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About This Manual vi

Introduction 
This AutoReceive Administrator Manual provides information on installing, configuring, and using Care360® AutoReceive. It 
also describes how to add, modify, and remove subscriptions that deliver results to the client’s printer or computer from 
various service providers, or subscriptions that allow the client to upload clinically relevant documents to Care360 EHR.

Intended Audience 
This administrator manual is intended for Quest Diagnostics® personnel who install, configure, maintain, and troubleshoot 
AutoReceive. The manual assumes the client’s computer, printer, and network (if applicable) are set up and ready to use, 
and that you are familiar with the basic skills needed to use them.

Note: For an explanation of subscriptions, see “Configuring Subscriptions” on page 14.
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What’s New in This Release 
AutoReceive 8.1 provides the following updates and enhancements:

• Care360 Interactive Notifications. Interactive Notifications, a service that can send a variety of timely notifications to 
Windows® desktops, is installed automatically (in most cases) after a successful AutoReceive upgrade. By default, 
clients will receive Quest Diagnostics news notifications as well as notifications of Interactive Notifications updates. If 
clients are also Care360 Labs & Meds users, clients can configure their Interactive Notifications subscription 
preferences to receive notifications of priority lab results, and clients can access the client supplies order form from the 
Interactive Notifications menu.

After the installation is complete, the Interactive Notifications icon ( ) appears in the system tray along with the 
AutoReceive icon ( ). When a notification is received, the Interactive Notifications icon blinks and the Interactive 
Notifications popup appears, as in the following example:

Information on the integration of the AutoReceive upgrade and the Interactive Notifications installation is documented 
in the AutoReceive Internal Release Notes.

• POCT results. Uploading point-of-care testing (POCT) results using an external device (such as HemoCue®) for 
delivery to Care360 Lab Orders and Results is no longer supported. All references to POCT results have been removed 
from the documentation.  

Note: There were no references to POCT results in the AutoReceive user interface, but POCT entries do remain in files 
such as app.properties and debug.log. 
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Documentation Conventions 
This manual uses the following conventions: 

• Manual titles, special terms, Web page and dialog box titles, menu items, toolbar button names, labels that appear on 
Web pages and dialog boxes, and keyboard key names appear in italic.

Italic is also used to indicate variables. For example, an email address might be presented as name@company.com. When 
typing the address, you would use the actual user name and company name rather than name and company.

• Words that are being emphasized appear in bold.

• Text that you type as well as messages and prompts that appear on the screen appear in this type style.

• The greater than symbol (>) indicates a series of menu items to click. For example, the instructions to click the File menu 
item and then click Open might be presented in the following way: “Click File > Open.” 

• This manual calls your attention to important information in several ways:  

• The following Microsoft® Windows operating systems are referred to collectively as User Account Control (UAC) 
operating systems:

• Windows 8

• Windows 8.1

• Windows 7

• Windows Vista®

• Windows Server® 2012 R2

• Windows Small Business Server (SBS) 2011 Standard

• Windows Server 2008 R2

• Windows Server 2008

UAC is Microsoft Windows security technology that limits applications to standard user security unless you explicitly 
request that the application be run with administrator privileges. AutoReceive requires administrator privileges to run 
properly in Service mode.

• For Windows 8 and Windows 8.1, the instructions in this manual assume the following:

• You are using a keyboard and mouse, not a touch screen.

• You are using desktop mode to access the AutoReceive menu. (To access the desktop mode from the Windows 8 and 
Windows 8.1 Start screen, press the Windows logo key + d.)

• For all operating systems, the instructions in this manual assume that the notifications area is expanded to show the 
AutoReceive icon.

• When viewing this manual using Adobe® Reader®, we recommend that you do the following to ensure optimal display:

1 Click Edit > Preferences. 

The Preferences dialog box appears. 

2 In the Categories list, click Page Display.

Note: A note indicates exceptions to the stated rule, or information that emphasizes or supplements important points 
in the main text. A note can supply information that might apply only in a special case. 

Caution! A caution indicates that failure to take or avoid a specified action could result in losing data. When you see a 
caution, follow the instructions carefully.
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3 In the Rendering area, clear the Enhance thin lines check box. You may also want to clear the Use 2D graphics 
acceleration check box, based on capabilities of your graphics card. 

4 Click OK. 

Note: The preceding steps are specific to Adobe Reader X; the procedure may vary based on the version you are using.
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Abbreviations and Acronyms 
The following is a list of abbreviations and acronyms that are used in this manual. 

Abbreviation/Acronym Description

DHCP Dynamic Host Configuration Protocol

DNS Domain Name Server

DPI Dots Per Inch

EHR Electronic Health Record

EMR Electronic Medical Record

HL7 Health Level 7 Standard Interface

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol, Secure

ISC Interface Support Center

JRE Java® Runtime Environment

KB Kilobyte

LAN Local Area Network

MB Megabyte

MCID Message Control ID

PDF Portable Document Format

QLS Quest Laboratory System

RAM Random Access Memory

SOAP Simple Object Access Protocol

TIQ Test In Question

TNP Test Not Performed

UAC User Account Control

UNC Universal Naming Convention

USB Universal Serial Bus
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Accessing the Documentation 
You can access installed AutoReceive client documentation in the following ways:

• Online help. The help provides overviews and step-by-step procedures for all AutoReceive tasks. It can be viewed with 
an Internet browser.

• User manual. Like the help, the user manual provides overviews and step-by-step procedures for all AutoReceive tasks, 
but it also includes screen captures and other diagrams. It is available as a PDF file that can be viewed online or printed.

Access the Online Help 

1 Do one of the following:

• Right-click the AutoReceive icon ( ) in the taskbar and click Help.

• From any of the subscription configuration dialog boxes, click the Help link in the upper-right corner

The AutoReceive help appears in a new browser window.

2 Do one or more of the following to access a help topic:

• On the Contents tab, click the appropriate book or topic:

• To view a topic, click the page icon ( ). 

• To expand a closed book, click the closed book icon ( ). 

• To collapse an open book, click the open book icon ( ).

• On the Index tab, click the appropriate letter in the list, and then click one of the listed keywords.

• On the Search tab, type the word or phrase that you want to find, and then click Search. From the list of search results, 
click the appropriate topic name.

• From the navigation bar above the topic, do one or more of the following: 

To do this Click this

See where the topic appears in the table of contents.

Note: If the topic is not included in the table of contents, an error message appears.

Go to the previous topic in the help system.

Note: If you are viewing the first topic in the help system, this button appears dimmed.

Go to the next topic in the help system. 

Note: If you are viewing the last topic in the help system, this button appears dimmed.

Display a list of related topics that provide additional information. 

Note: You can also click the Related Topics link at the bottom of the topic.

Display the Contents, Index, and Search tabs after accessing a task-specific help topic. 

Note: This button does not appear when you access the general help. 

Print a topic
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• At the top of the help topic, click any of the links that appear within the navigation links. The navigation links show 
where the current topic appears in the hierarchy of the Contents. (You might have to scroll the window to see the 
navigation links.)

3 When you are finished viewing the help, close the help browser window by clicking the close button ( ) in the upper-
right corner of the window.

Access the User Manual 

1 Do one of the following, depending on your operating system:

• From the Windows 8, Windows 8.1, or Window Server 2012 R2 Apps screen, click AutoReceive User Manual.pdf. 

• From all other Windows operating systems, click Start > All Programs > AutoReceive > AutoReceive User Manual.pdf. 

The Care360 AutoReceive User Manual PDF file opens in the Windows Reader app or Adobe Reader. 

2 Use the bookmarks in the left pane of Adobe Reader to navigate through the chapters and sections in the PDF file.

Notes:
• The name of the currently displayed topic is not a clickable link.

• Although you can always go higher in the hierarchy, you cannot go deeper using the navigation links.
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Related Documentation 
In addition to this manual, the following manuals are also available for related Care360 products:

• Care360 AutoReceive User Manual. Provides information on configuring subscriptions, changing connection settings, 
and troubleshooting. It is intended for end users of AutoReceive.

• Care360 Hub Information Services Administrator Manual. Provides information on using Hub Administration to configure 
and manage Hub accounts, providers, vendors, and users. It is intended for Quest Diagnostics personnel who are 
responsible for initial and ongoing Hub administration.

• Quest Diagnostics Data Exchange Services Orders and Results Programmer Reference. Provides information on creating 
client applications that interact with the Data Exchange. It is intended for programmers who will write client applications 
to communicate with the Data Exchange via the Order and Lab Results services. 

• Care360 Labs & Meds User Manual. Provides information on accessing and using the Care360 Labs & Meds product. It 
is intended for end users of Care360 Labs & Meds, which include physicians, clinicians, phlebotomists, clinical office 
staff, and administrative office staff.



 1

Chapter 1: Getting Started 

In This Chapter:
• About AutoReceive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

• System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

• Installing AutoReceive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

• Logging In to AutoReceive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

• Configuring Subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

• Configuring HL7 Test Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

• Configuring Printable Test Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

• Configuring Clinical Document Upload . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

• Configuring AutoReceive to Write to a Network Drive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

• Uninstalling AutoReceive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32



Getting Started 2

About AutoReceive
AutoReceive, part of the Care360 suite of products, provides a secure method for the following:

• Receiving, routing, and storing lab results from Quest Diagnostics or radiology results from other service providers. The 
lab and radiology results are available in HL7 or printable (PDF) formats, depending on how AutoReceive is configured.

• Uploading clinically-relevant scanned documents to your computer or network drive, and transferring them 
electronically into Care360 EHR.

The following graphic illustrates the process of receiving lab results from a Quest Diagnostics service provider using 
AutoReceive as well as the process for uploading clinical documents to Care360 EHR.

AutoReceive Subscriptions 
A subscription is a defined delivery method that identifies the lab or radiology result document types (HL7 or PDF) that you 
want to receive, or the location of the files that you can upload (scanned clinical documents).

Lab and radiology result subscriptions include how and when results are delivered to you, and how you prefer the results be 
stored, saved, or printed for clinical use. You can create any number of HL7 and PDF subscriptions, each with differing 
delivery options. Lab and radiology result subscription parameters include the following: 

• Document type (for example, HL7 or PDF)

• Subscription name

• Save or print location (defined at your discretion)

• Type of result (final results only or partial and final results)

• Frequency of transmission (for example, every 60 minutes)

• Disabled days of the week (for days your office is closed)

• Print order (for example, by file date or file name)
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• HL7 filename extension (for HL7 subscriptions only)

• Quest Diagnostics account (provider account) (a combination of information identifying the care site and Quest 
Diagnostics account number)

A Quest Diagnostics account (provider account) can be associated with only one HL7 subscription and one PDF 
subscription type. If you want reports from all of your Quest Diagnostics accounts (provider account) to be delivered 
according to the same set of parameters, that is, at the same time(s) each day, to the same printer/folder, etc., you would 
configure only two subscriptions—one for HL7 and one for PDF— and associate all your Quest Diagnostics accounts 
(provider accounts) with these two subscription types.

If, however, you want to specify variations to your subscriptions to accommodate differing delivery requirements among 
your clinicians, you can create and name additional HL7 and PDF subscriptions and associate them with accounts that are 
not already associated with another subscription of the same document type.

Example Subscription

If you want to receive HL7 final results (document and result type) from Quest Diagnostics for the Northern Medical Group 
(provider account), you can configure an HL7 subscription to retrieve results every 60 minutes (frequency of transmission) 
to a folder on your network (save location). You might have already configured other HL7 subscriptions with differing 
parameters for other provider accounts, but AutoReceive offers the flexibility to configure additional subscriptions to suit 
your clinical requirements. For more information on creating subscriptions, see “Configuring Subscriptions” on page 14.

The following image shows two configured subscriptions and the specified delivery parameters for the selected account. For 
more information, see “Accessing Account and Subscription Summary Information” on page 39. 
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Running AutoReceive as a Windows Service 
AutoReceive runs as a Windows® service by default (called Service mode), unless a previous installation of AutoReceive on 
the same computer ran as a standard application (called Classic mode), in which case this setting is retained. A Windows 
service is an application that runs when Windows is started, and continues to run in the background as long as Windows is 
running. Running as a Windows service enables AutoReceive to continue downloading or printing results even when no user 
is logged in to Windows.

There are no visible changes to the AutoReceive user interface when AutoReceive is running as a Windows service, except 
for some minor modifications to the status messages that appear in the status window. (For a list of these status messages 
and for information on setting their display, see “Changing Notification Options” on page 45). 

You can still access the AutoReceive menu options from the notification area (at the far right of the Windows taskbar), and 
you can start the AutoReceive application from the Start menu. The primary difference is that exiting AutoReceive (by right-
clicking the AutoReceive icon ( ) and selecting Exit) closes the user interface, but does not stop the Windows service from 
running. 

Note: The AutoReceive service operates properly on Windows UAC operating systems only if you run it as an 
administrator.
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System Requirements 
Review the hardware and software requirements listed in the following sections before you install AutoReceive: 

• “Operating Systems”, below.

• “Printer Requirements” on page 6.

Operating Systems 
AutoReceive supports the following operating systems:

• Windows 8.1 (32-bit and 64-bit)

• Windows 8 (32-bit and 64-bit)

• Windows 7 (32-bit and 64-bit)

• Windows Vista (32-bit and 64-bit)

• Windows XP (32-bit)

• Windows Server 2012 R2 (64-bit)

• Windows Small Business Server (SBS) 2011 Standard (64-bit)

• Windows Server 2008 R2 (64-bit)

• Windows Server 2008 (32-bit and 64-bit)

• Windows Server 2003 (32-bit)

For all operating systems, your computer hardware must meet the requirements recommended by Microsoft. In addition, 
your computer must be connected to the Internet.

If you are using a modem, the minimum required modem speed is 56 KB. 

Notes:
• Quest Diagnostics will support the Windows XP (all service packs) and Windows Server 2003 operating systems as 

long as they are supported by Microsoft Corporation.

• Adobe Reader version 5.0 or newer is required for viewing documentation PDF files, and files that you download using 
AutoReceive.

• A browser is required for viewing the AutoReceive online help.
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Printer Requirements   
The printer for receiving and printing documents must be a laser printer that is connected to a workstation or office network. 
The following requirements apply: 

• Microsoft Windows-supported printer

• Network, serial, parallel, or USB connection

• Print drivers appropriate to your computer’s operating system 

• Support for landscape and portrait orientation

• 200 dpi print resolution or higher

The following is a list of the printers with which AutoReceive has been tested. However, you are not limited to the printers 
in this list.

• Lexmark® E322

• OKI® B6500

• OKI B6300

• OKI B4350

• OKI B4300

• OKI C6100

• OKI C5400 

Note: PostScript® printer drivers are not supported.
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Installing AutoReceive 
A complete AutoReceive installation involves the following main steps:

• Installing the AutoReceive application by running the AutoReceive installation program.

• Configuring AutoReceive for the client’s network and AutoReceive login credentials. For an overview of configuring the 
client’s network and AutoReceive login credentials, see “Logging In to AutoReceive” on page 11.

• Creating at least one subscription. For an overview of the subscriptions, see “Configuring Subscriptions” on page 14.

• Activating AutoReceive.

You are prompted for each step automatically as the installation process progresses. While you can stop the process at any 
of these steps and return to it later, the installation is not complete until AutoReceive is activated. 

Install AutoReceive

1 If you are updating an existing version, exit AutoReceive before you continue. (If you are installing AutoReceive for the 
first time, begin with step 2.)

To exit, do the following:

a Right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

b When prompted, click Yes to confirm that you want to exit.

2 Insert the AutoReceive product installation medium (for example, flash drive or CD) into the appropriate drive, and then 
double-click AutoReceive-8.0.

If you are installing on Windows UAC operating systems, proceed to step 3. Otherwise, proceed to step 4.

Note: To install AutoReceive on Windows UAC operating systems, you must run the installer as an administrator on the 
computer. On any platform, you must have permission to install applications, and you must have sufficient permissions to 
run the AutoReceive executable file and the Java Runtime Environment (JRE) that is installed with AutoReceive. You must 
have permissions for the following directories:
• If you are installing AutoReceive for a 64-bit version of Windows, AutoReceive installs to this directory:

C:\Program Files(x86)\AutoReceive

• If you are installing AutoReceive for a 32-bit version of Windows, AutoReceive installs to this directory:

C:\Program Files\AutoReceive
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3 If you are installing on Windows UAC operating systems, a User Account Control window appears, prompting you as to 
whether or not the installation should continue. Confirm that you want the installation to continue. 

The installer Introduction screen appears.

4 In the Introduction screen, click Next.  

The Please Wait screen appears while the installer prepares to install AutoReceive. 

Tip: If the Please Wait screen appears for an extended amount of time (without finding a previous AutoReceive 
installation), click Previous and then click Next to continue the installation (bypassing the Please Wait screen).
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5 If a previous version is detected on your computer, do the following:

a Exit AutoReceive (as described in step 1), and when the Uninstall Previous Version screen appears, click Next. 

b After the previous version has been uninstalled, click Next to continue the installation.

6 Review the Pre-Installation Summary screen for accuracy. 

7 If the Pre-Installation Summary screen information is correct, click Install.
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Installation may take a few moments. When AutoReceive is installed on your computer, the Install Complete screen 
appears. 

8 Click Done.

The AutoReceive splash screen appears. 

The splash screen provides a visual indicator notifying you of AutoReceive activity (for example, loading and caching 
document types and provider information from the hub).

AutoReceive starts automatically, and the Network Configuration dialog box appears. 

9 Continue with “Logging In to AutoReceive” on page 11 to complete the Network Configuration dialog box. 

Note: If necessary, you can click Cancel and access the Network Configuration dialog box later to complete the 
configuration.
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Logging In to AutoReceive 
AutoReceive starts immediately after a successful installation and prompts you to identify the computer’s Internet 
connection—modem or local area network (LAN)—and enter a valid username and password for connecting to the service 
on the hub. After you log in and configure the client’s subscription(s), AutoReceive remains active as long as the client’s 
computer is on. While active, an AutoReceive icon ( ) appears in the notification area, which you can use to access a 
number of menu options. 

AutoReceive remains active until you manually stop the AutoReceive service (if running in Service Mode), exit AutoReceive 
(if running in Classic Mode), or shut down the computer. For information about exiting, see “Starting and Exiting 
AutoReceive” on page 50. 

Notes:
• You must run the AutoReceive service as an administrator on Windows UAC operating systems. Failure to do so may 

cause AutoReceive to run incorrectly. To run AutoReceive as an administrator, right-click AutoReceive and select Run as 
administrator.

• You can change the connection type later, if necessary, using the Network Configuration option on the right-click menu 
available from the AutoReceive icon ( ) in the notification area. See “Changing Connection Settings” on page 47 for 
more information.

• You are allowed three attempts to successfully log in. After three failed login attempts, AutoReceive automatically exits. 
The next time AutoReceive opens, the last known successful login information is used. 

• It is recommended that you expand the notification area to always show AutoReceive. To do so, click the icon to expand 
the notification area, click Customize, and select the Always show all icons and notifications on the taskbar check box. (For 
Windows XP, right-click the task bar, select Properties, and clear the Hide inactive icons check box.)
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Log In to AutoReceive 

1 In the Network Configuration dialog box, which appears immediately after installation, identify the computer’s Internet 
connection by doing one of the following: 

• LAN connection. Click the LAN option button if the computer accesses the Internet using a local area network (LAN).

If the LAN connection uses a proxy server, select the Use proxy server check box, and complete the following:

a In the Proxy host box, type the name of the host for the proxy server.

b In the Port box, type the port number for the proxy server.

If the proxy server requires a log in, enter the corresponding username and password. This username and password 
combination is not the AutoReceive username and password.

a In the Username box, type the username for logging in to the proxy server.

b In the Password box, type the password for logging in to the proxy server. 

• Modem connection. Click the Modem option button if the computer accesses the Internet using a modem. To 
automatically disconnect the modem after each transmission of results, select the Disconnect after finished download 
check box.

2 Click OK.

3 In the AutoReceive Setup dialog box, type the AutoReceive username and password, and then click OK.

If the AutoReceive connection to the hub is successful, the AutoReceive Configuration dialog box appears. 

Note: Some LAN connections use a proxy server for HTTP and HTTPS connectivity. To determine if the LAN 
connection uses a proxy server, check the Internet browser’s settings as follows:
1 In the browser menu bar, select Tools > Internet Options. 
2 Click the Connections tab. 
3 Click LAN Settings. 

If the Use a proxy server for your LAN check box is selected, the LAN connection uses a proxy server.
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4 Begin configuring one or more subscriptions for the client.  

For an overview of configuring subscriptions, see “Configuring Subscriptions” on page 14. Otherwise, skip to one of the 
following sections for instructions on creating a subscription for a specific result or clinical document:

• “Configuring HL7 Test Results” on page 17.

• “Configuring Printable Test Results” on page 22.

• “Configuring Clinical Document Upload” on page 28.

5 After you have configured one or more subscriptions, click Close.

6 When prompted, click Activate to activate your AutoReceive account. 

The AutoReceive installation is registered with the hub and a unique client ID is created that identifies this AutoReceive 
installation. AutoReceive can now begin receiving results, and/or the client can begin uploading clinical documents.

Note: You must configure at least one subscription to complete the AutoReceive installation. The final step of the 
installation process, activating AutoReceive, requires that at least one subscription be configured.
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Configuring Subscriptions 
Configuring a new subscription is a three-step process. All three steps must be completed for the subscription to be 
considered active so that you can begin receiving results. An overview of the three steps follows: 

1 Choose Subscription. Select the subscription type (HL7, Printable, or Clinical Document Upload).

2 Configure Subscription. Specify the subscription parameters, including the retrieval schedule and the location to save or 
print the results.

3 Associate Account(s). Associate the subscription with one or more Quest Diagnostics provider account(s). This step 
applies to HL7 and Printable subscriptions only.

At any time during the configuration process, you can monitor your progress by reviewing the Steps to configure AutoReceive 
area at the top of the configuration dialog box. A check mark appears next to each completed step. 

Step 1: Choose Subscription
The first step in creating a new subscription is to select the subscription type, either HL7, Printable (PDF) test results, or 
Clinical Document Upload. Based upon this selection, the appropriate parameters appear for the second step of the 
configuration process.

Step 2: Configure Subscription
You can uniquely configure each subscription to meet the needs of your office. You need to consider and make selections 
for the following parameters for each subscription you configure:

• Subscription name. The default name is HL7 Test Results for an HL7 subscription, Printable Test Results for a PDF 
subscription, or Clinical Document Upload for a Clinical Document Upload subscription. You can change the name to 
something more meaningful to you if you want. For example, if you have multiple service providers from whom you are 
receiving results, you may want to identify the subscription by the service provider’s name. An example might be Quest 
Diagnostics HL7 Test Results.

• File naming mode. Two naming modes indicate how HL7 and PDF files are named: Standard and Enhanced. The Standard 
naming mode uses a timestamp to name the file, while the Enhanced mode adds a Provider Account ID, Message 
Control ID (MCID), and Document ID (PDF files only) to the file name to aid in matching an HL7 file to any corresponding 
PDF file(s). 

Examples of the Enhanced file formats are shown below:

• HL7: Provider Account ID-MCID-timestamp.hl7

• PDF: Provider Account ID-MCID-Document ID-timestamp.pdf

Caution! If you close the Subscription Configuration dialog box prior to completing the configuration, your configuration 
changes are not saved. The three configuration steps listed above have associated parameters from which you must make 
selections. See the descriptions below for the selections available for each of the three configuration steps.

Note: The file naming mode you select applies to all subscriptions you configure; that is, you only need to set it once. 
You do not need to select it separately for each subscription.
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Enhanced file naming examples:

• HL7: 10088-10200001-1342806194056.hl7

• PDF: 10088-10200001-87235-1342806194056.pdf

• Print Order. If you selected the Enhanced file naming mode, you can choose the print order in which your results are 
sorted. You can choose to sort results by File Date or File Name. (For standard file naming, the default is to print the results 
in the order in which they are received.)

• Retrieval schedule. The retrieval schedule is defined by your selections for both a retrieval time and a result type. Choose 
a retrieval time by selecting either a specific time or an interval. Examples include:

• Specific time. You may want to receive results first thing in the morning and at the end of the day. To do this, you can 
select 8:00 A.M. and 6:00 P.M. as the specific times for receiving your results. 

• Interval. You may want to receive results every four hours. To do this, you can set an interval by selecting a duration, 
for example, every four hours, and a starting time, for example 8:00 A.M. The starting time is used to calculate each 
interval in a 24-hour period. For this example, results save at 8:00 A.M, 12:00 P.M., 4:00 P.M., 8:00 P.M., 12:00 A.M., 
and 4:00 A.M.

Additionally, you can determine the result type by selecting either Final Results Only or Partial and Final Results for the 
specified retrieval time.

• Final results only. If you make this selection, you receive results only when all the results are complete for a specific 
requisition. If you choose this option, you may want to place orders that require more than one day to complete on a 
separate requisition. This way, you do not delay the receipt of the patient’s labs that have quicker turnaround time.

• Partial and final results. If you make this selection, you receive the latest result at the time of retrieval, whether it is 
a partial or final result.

• Disabled day(s) of the week. You may want to disable result retrieval on days that your office is closed. To do this, select 
the day, or days of the week to disable the results retrieval. You cannot disable results retrieval for all the days of the 
week. To disable retrieval for more than 6 days, for example, if your office will be closed for a week, exit AutoReceive until 
you want to resume results retrieval again. See “Starting and Exiting AutoReceive” on page 50.

• Save location. Determine where you want to save and/or print your HL7 and PDF results. Due to the format of HL7 files, 
they cannot be printed; they can only be saved to a folder on your computer or network.

HL7 subscriptions have additional configuration options available such as filename extensions and sorting of saved 
results. For more information on the HL7 configuration options, see “Configuring HL7 Test Results” on page 17.

Note: When you select a specific time or interval, AutoReceive retrieves results within a range of nine minutes prior 
to nine minutes after the selected time.

Notes:
• The starting time (for intervals) does not designate the first time the results are saved. You receive results at the 

next scheduled interval after you complete the configuration. For example, if the intervals are 8:00 A.M., 12:00 P.M., 
4:00 P.M., 8:00 P.M., 12:00 A.M., and 4:00 A.M. (every four hours) and you are setting the configuration at 
9:00 A.M., you receive results for the first time at 12:00 P.M.

• If you shut your computer down (without exiting AutoReceive) in the evening and then restart it in the morning, new 
results save at the next scheduled interval.
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Step 3: Associate Account(s)
The final step of the configuration process is to associate a provider account, or accounts, to the new subscription. You can 
choose from the list of available accounts that appears on the Associate Accounts dialog box. You can select multiple 
accounts for an individual subscription, but each account can be associated with only one HL7 subscription and one PDF 
subscription.

Once a subscription is saved, you can access it later to make any necessary modifications. See “Managing Subscriptions” on 
page 39 for more information on modifying existing subscriptions. To create new subscriptions, see one of the following:

• “Configuring HL7 Test Results” on page 17.

• “Configuring Printable Test Results” on page 22. 

Note: This step is not required for a Clinical Document Upload subscription. 
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Configuring HL7 Test Results 
HL7 test result files are saved to a specified location on your computer or network where they can then be retrieved by your 
electronic medical record (EMR) system or any other system that reads HL7 test results. Due to their format, HL7 files 
cannot be printed.

To review the detailed descriptions of subscription parameters, see “Configuring Subscriptions” on page 14. Two parameters 
that are specific to HL7 subscriptions are the following: 

• HL7 file extensions. The default value for the HL7 file name extension is hl7. If your EMR system does not recognize files 
with an .hl7 extension, type the HL7 filename extension that is appropriate for your receiving system (for example .res 
or .hll).

• Result sorting. HL7 results can be sorted into sub-folders for each account that is associated to the subscription. If you 
want to sort your HL7 results in this manner, select the Automatically create file sub-folders using Account IDs check box 
available in the Distribution area of the Subscription Configuration dialog box. See “Configuring HL7 Test Results,” step 11 
for more information. 

Configure HL7 Test Results 

1 If the AutoReceive Configuration dialog box is not already open, right-click the AutoReceive icon ( ) in the notification 
area, and then click Configure Subscriptions.

2 In the Create a New Subscription list, click HL7 Test Results. 
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3 In the File Naming Mode area, click either the Standard or Enhanced option button to indicate how result files are named. 
(For information on the naming modes, see “File Naming Mode” under “Step 2: Configure Subscription” on page 14.) 

4 In the Print Order area, click either the File Date or File Name option button to indicate how results are sorted or 
printed.  

5 Click Continue.

6 In the Subscription Name box, type a subscription name for the HL7 results, or leave the default name HL7 Test Results.

7 Set the retrieval schedule by doing one of the following:

• Receive results at specific times. To receive results at specific times, do the following:

a Click the At specific times option button, and then click Choose. 

b In the Select Time(s) dialog box, select the check box next to each desired retrieval time. 

Notes:
• The file naming mode you select applies to all subscriptions you configure (including HL7 and Printable). If you have 

selected the mode previously, you do not need to select it again.

• If you change the file naming mode, the setting takes effect immediately (that is, the next time results are 
downloaded).

• If you want to be able to configure the order in which results are sorted or printed, click the Enhanced option button.

Note: To use this feature, you must first select Enhanced as the file naming mode. 



Getting Started 19

c For each selected time, click either Final Results Only or Partial and Final Result, as follows. In the Select Time(s) 
dialog box, select the check box next to each desired retrieval time. For each selected time, specify whether you 
want to receive Final Results only or Partial and Final Results. 

• To receive only final result reports, click Final Results only. All tests on the requisition must be complete to 
receive results.

• To receive the latest results, whether partial or final, click Partial and Final Results.

d When you are finished selecting the results type for each specific time, click OK.

• Receive results at regular intervals. To receive results at regular intervals, do the following:

a Click the Every option button, and then click the interval duration and starting time. 

b Determine the type of report you want to receive, as follows: 

• To receive only final result reports, click the Final results option button. All tests on the requisition must be 
complete to receive results.

• To receive the latest results, whether partial or final, click the Partials and finals option button.

8 To disable retrieval for specific days of the week, select the appropriate day of the week check box(es). 
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9 In the Save results in box, do one of the following to specify the location to save the HL7 results: 

• Type the local directory or network path.

• Click Browse to locate the local directory or network path.

The network path must be formatted as follows:

• Non-UAC operating systems (Windows XP and Windows 2003). You can enter the network path using a mapped 
drive letter, or you can enter the path using the universal naming convention (UNC). 

• UAC operating systems. You must enter the network path using the UNC. 

The format for the UNC is \\servername\directorypath.

Examples:

• Network path with mapped drive letter: Y:\AutoReceive HL7 Results

• Network path with UNC:  \\OfficeServer_1\Physicians\AutoReceive HL7 Results

10 To test the directory or network path, click Test. 

If you specified a directory that does not exist, the directory is created, and a sample document (test.hl7) is downloaded 
to the specified directory. 

11 To sort the HL7 results into sub-folders by the account associated with this subscription, select the Automatically create 
file sub-folders using Account IDs check box.

12 In the HL7 File Name Extension box, type the file name extension used by your EMR system (if it is different from hl7). 

13 When you are finished configuring the HL7 subscription and have successfully tested it, click Continue.

The Associate Accounts dialog box appears.

14 Do one of the following to select the provider account(s) with which the subscription is to be associated:

• Select the individual check box for each provider account.

• Click Select All to select all provider accounts.

Note: You must also configure the AutoReceive service to log on as the user account that has read and write 
permissions to the network path. Otherwise, AutoReceive can run only in Classic mode. For instructions, see 
“Configuring AutoReceive to Write to a Network Drive” on page 30

Note: If AutoReceive is running as a Windows service and you specified a network drive in step 9, clicking Test may not 
accurately confirm the ability to save a results file because the account under which the service runs may not have the 
same access permissions as the current user. If you encounter problems saving files to a network drive, make sure that 
the AutoReceive service is configured to log on as the user account that has read and write permissions to the network 
path as explained in “Configuring AutoReceive to Write to a Network Drive” on page 30. If that does not work, try 
saving to a local drive, or switch AutoReceive to Classic mode instead of Service mode. For information on switching 
AutoReceive modes, see “Switching Between Service Mode and Classic Mode” on page 56.
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If you want to clear the selected accounts, click Clear All, and then make your selections again. 

15 Do one of the following: 

• To return to the previous configuration screen to make changes prior to saving, click Back. Any changes made to the 
account associations are not saved.

• To save your selections and return to the first configuration screen, click Save.

If you specified a directory (in step 9) that does not yet exist on your computer, you are prompted to create the new 
directory. To create the new directory, click Yes to All. 

A message appears indicating that the folder(s) have been created.

• To exit the subscription configuration (without saving your changes) and return to the first configuration screen, click 
Cancel.

The Manage Subscriptions dialog box appears, displaying a summary of the subscriptions created so far. Click a 
subscription name to display the corresponding summary. 

16 Click Close to exit the Manage Subscriptions dialog box. 

Notes:
• Accounts that appear shaded and display the status of Pre-Assigned are not available for selection; they are already 

associated with another subscription.

• If your accounts do not appear for selection on the Associate Accounts dialog box, contact customer support.
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Configuring Printable Test Results 
Printable (PDF) results can be saved to your computer or network drive, and can be printed automatically on a local or 
network printer. To review the detailed descriptions of subscription parameters, see “Configuring Subscriptions” on page 14.

Configure Printable Test Results 

1 If the AutoReceive Configuration dialog box is not already open, right-click the AutoReceive icon ( ) in the notification 
area, and then click Configure Subscriptions. 

2 In the Subscription type list, click Printable Test Results. 

3 In the File Naming Mode area, click either the Standard or Enhanced option button to indicate how result files are named. 
(For information on the naming modes, see “File Naming Mode” under “Step 2: Configure Subscription” on page 14.) 

4 In the Print Order area, click either the File Date or File Name option button to indicate how results are sorted.  

Notes:  

• The file naming mode you select applies to all subscriptions you configure (including HL7 and Printable). If you 
selected the mode previously, you do not need to select it again.

• If you change the file naming mode, the setting takes effect immediately (that is, the next time results are 
downloaded).

• If you want to be able to configure the order in which results are sorted or printed, click the Enhanced option button.

Note: To use this feature, you must first select Enhanced as the file naming mode. 
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5 Click Continue. 

6 In the Subscription Name box, type a subscription name for the PDF results, or leave the default name Printable Test Results.

7 Set the retrieval schedule by doing one of the following:

• Receive results at specific times. To receive results at specific times, do the following:

a Click the At specific times option button, and then click Choose. 

b In the Select Time(s) dialog box, select the check box next to each desired retrieval time. 

c For each selected time, click either Final Results Only or Partial and Final Result, as follows. 

• To receive only final result reports, click Final Results Only. All tests on the requisition must be complete to 
receive results.

• To receive the latest result, whether it is partial or final, click Partial and Final Results.

d When you are finished selecting the results type for each specific time, click OK.

• Receive results at regular intervals. To receive results at regular intervals, do the following:

a Click the Every option button, and then click the interval duration and starting time. 

b Determine the type of report you want to receive, as follows: 

• To receive only final result reports, click the Final results option button. All tests on the requisition must be 
complete to receive results.

• To receive the latest result, whether it is partial or final, click the Partials and finals option button.

8 To disable retrieval for specific days of the week, select the appropriate day check box(es). 
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9 Determine how you want the results to be distributed (to printer(s) and/or to disk) by doing one or more of the following:

• Printer. To automatically print test results to one or more printers, do the following:

a Select the Print check box, and then click a local or network printer. To select more than one printer, press and hold 
the Ctrl key while you click the printers.

b If applicable, specify the Number of copies you want to print for each test result (maximum of 10 copies). 

c If you selected two or more copies for each test result, you can have your results collated by selecting the Collate 
Multiple Reports check box. 

d To generate a summary of your printed test results, select the Enable Print Summary Page check box. 

An example of the Result Summary Report is shown below.

The Result Summary Report displays a summary of printed Lab results contained within a batch including Test in 
Question (TIQ), Test Not Performed (TNP), and Abnormal results. The Result Summary Report also displays a 
summary of Radiology results contained within a batch listed separately from the Lab results.
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In the event there are no results for a result type (that is, lab or radiology), only the section heading appears.

e To generate an advisory message report alerting you that your batch contains Abnormal, Test in Question (TIQ), 
or Test Not Performed (TNP) results, select the Enable Advisory Message Page check box.

An example of the Advisory Message Report is shown below.

The Advisory Message Report highlights patient orders being requested in a batch that contain Test in Question 
(TIQ) and Test Not Performed (TNP) results.

• Disk. To save the results to a local or network drive, do the following:

a Select the Save files to disk check box

b Do one of the following:

• Type the directory or network path where you want to save the files. For example, type C:\AutoReceive 
Printable Results.

• Click Browse to locate the directory or network path where you want to save the printable results.

Notes:
• Reports with an advisory message (TIQ, TNP) print before the rest of the results within the batch.

• If you have requested advisory messages for a result category, and there are no messages for that category 
when the report is run, no corresponding heading for that category appears in the Advisory Message Report.
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10 To test your configuration settings, click Test. 

A sample document (test.pdf) is downloaded and one or both of the following occurs depending on the selected 
configuration settings:

• If you selected to save results to disk, the sample document is stored in the specified directory, and the following 
message appears. 

• If you selected to distribute results to a printer, the sample document is sent to the specified printer.

11 When you have finished configuring the Printable subscription and have successfully tested it, click Continue.

The Associate Accounts dialog box appears.

12 Do one of the following to select the provider account(s) with which the subscription is to be associated:

• Individually select the account check boxes.

• Click Select All to select all accounts.

If you want to clear the selected accounts, click Clear All, and then make your selections again. 

13 Do one of the following: 

• To return to the previous configuration screen to make changes prior to saving, click Back.

• To save your selections and return to the first configuration screen, click Save. 

If you are prompted to create a directory in which to save the results, click Yes to all. When you are finished 
configuring subscriptions, click Close from the configuration screen.

Caution! If AutoReceive is running as a Windows service and you specified a network drive in step 9, clicking Test 
may not accurately confirm the ability to save a results file because the account under which the service runs may 
not have the same access permissions as the current user. If you encounter problems saving files to a network drive, 
try saving to a local drive, or switch AutoReceive to Classic mode instead of Service mode. (For more information, 
see “Switching Between Service Mode and Classic Mode” on page 56.)
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• To exit the subscription configuration (without saving your changes) and return to the first configuration screen, click 
Cancel.

14 If you specified a directory (in step 9) that does not yet exist on your computer, you are prompted to create the new 
directory. To create the new directory, click Yes to All. 

When you have completed the subscription, the Manage Subscriptions dialog box appears, displaying a summary of the 
subscription you created. 

Notes:
• If you want to clear the selected accounts, click Clear All and make your selections again.

• Accounts that appear shaded and display the status of Pre-Assigned are not available for selection; they are 
already associated with another subscription.

• If your accounts do not appear for selection on the Associate Accounts dialog box, contact customer support.
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Configuring Clinical Document Upload
Non-electronic, clinically-relevant documents (scanned documents) can be uploaded to your computer or network drive, 
and transferred electronically into Care360 EHR via the hub. To review detailed descriptions of subscription parameters, see 
“Configuring Subscriptions” on page 14. 

Configure Clinical Document Upload

1 If the AutoReceive Configuration dialog box is not already open, right-click the AutoReceive icon ( ) in the notification 
area, and then click Configure Subscriptions.

2 In the Create a New Subscription list, click Clinical Document Upload. 

3 Click Continue. 

4 In the Subscription Name box, type a name for this clinical document upload subscription, or leave the default Clinical 
Document Upload name. 

Note: This option is available only if the hub account for this client has the Document Routing (upload) service 
activated. 
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5 In the Parent Path box, type a directory path or click Choose to select the directory where AutoReceive looks for 
documents to be uploaded to the hub. 

A folder named Document Upload is created within the selected parent path. Files copied to this directory are sent to the 
hub.

To upload a file, AutoReceive must have the ability to gain exclusive access to the file. The Windows user that 
AutoReceive is running under must have write permissions to the directory involved. Also, the file cannot be marked as 
Read Only. The file must be copied completely to the directory before it can be uploaded to the hub.

A sub-folder named errors is created inside the Document Upload folder. Files that cannot be processed because they are 
too large (larger than 5MB) are placed in this folder. 

• Files that can’t be processed because of communication failures or the inability to establish an exclusive lock remain 
in the Document Upload folder and the system tries to re-send them.

• Any folder within the Document Upload folder is not processed.

6 In the Provider Account list, click a provider account. This identifies the organization in Care360 where the documents are 
to be sent. 

When you have completed the subscription, the Manage Subscriptions dialog box appears, displaying a summary of the 
subscription you created. 

Notes:
• AutoReceive must be able to have an exclusive lock on a document before it can be uploaded. The folder selected 

as the parent path must have proper permissions set so AutoReceive can establish an exclusive lock on the 
documents.

• You can only have one parent path per subscription.

Note: The client is responsible for ensuring documents are placed correctly in this directory.

Note: You can only have one provider account defined for a subscription. 
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Configuring AutoReceive to Write to a Network Drive
By default, the AutoReceive service runs as the Local System account and does not have privileges to write to a network 
drive. To allow the AutoReceive Service to write to a network drive, the service must be re-configured to run using an account 
that has read and write permissions to the specified network drive.

To re-configure the service, log in to Windows as an Administrator and stop AutoReceive (both the user interface and service 
if running in Service mode). For more information, see “Starting and Exiting AutoReceive” on page 50.

Configure AutoReceive to Write to a Network Drive

1 Do one of the following, depending on which operating system you are using:

• From Windows 8, Windows 8.1, or Windows Server 2012 R2 desktop mode:

a Right-click the taskbar and click Task Manager. 

b In the Task Manager dialog box, click the Services tab. (If the Services tab is not visible, click More Details.)

c If you are using Windows Server 2012 R2, right-click AutoReceive and click Open Services.

• From all other Windows operating systems, navigate to the Control Panel as you usually do, and then navigate to 
Administrative Tools > Services. (For example, if you are using Windows 7, you would click Start > Control Panel > System 
and Security > Administrative Tools > Services. If you are using Windows Server 2008, you would click Start > Settings > 
Control Panel > System and Maintenance > Administrative Tools > Services.)

2 Right-click AutoReceive, and then click Properties.
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3 In the AutoReceive Properties dialog box, click the Log On tab.

4 Click the This account option button, and type the name of the account that has read and write permissions to the network 
drive.

5 In the Password box, type the password, and then in the Confirm password box, type the password again.

6 Click OK.

The account you entered now appears in the Log On As column in the list of services. 

7 Start AutoReceive. If AutoReceive is running in Classic mode, set it to run as a Service:

a Right-click the AutoReceive icon ( ) and click Advanced Settings.

The Advanced Settings dialog box appears.

b Click the Service option button and click OK.

8 Right-click the AutoReceive icon ( ) and click Configure Subscription.

9 In the Save results in box, type the network path of the file in which you want to save your results.

Note: Use UNC (\\servername\directorypath) for the network path. The path must not contain a drive letter, and the 
folder must be accessible by the account configured in step 4. 
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Uninstalling AutoReceive 
If you need to uninstall AutoReceive, use the Windows Control Panel. You must exit both the AutoReceive user interface and 
service before uninstalling. 

Uninstall AutoReceive from UAC Operating Systems

1 If AutoReceive is currently running, exit AutoReceive before you continue.

To do so, right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2 If AutoReceive is running as a service, stop the service by doing the following, depending on your operating system:

• From Windows 8, Windows 8.1, or Windows Server 2012 R2 desktop mode:

a Right-click the taskbar and click Task Manager. 

b In the Task Manager dialog box, click the Services tab. (If the Services tab is not visible, click More Details.)

c If you are using Windows Server 2012 R2, right-click AutoReceive and click Open Services.

d Right-click AutoReceive.

e Click Stop.

• From all other Windows operating systems, navigate to the Control Panel as you usually do, and then navigate to 
Administrative Tools > Services. (For example, if you are using Windows 7, you would click Start > Control Panel > System 
and Security > Administrative Tools > Services. If you are using Windows Server 2008, you would click Start > Settings > 
Control Panel > System and Maintenance > Administrative Tools > Services.) Then do the following:

a Right-click AutoReceive.

b Click Stop (or Stop Service).

3 When you have exited the AutoReceive user interface and stopped the AutoReceive service, navigate to the Control Panel 
as you usually do on your operating system. For example:

• From Windows 8, Windows 8.1, and Windows Server 2012 R2, you could navigate to the Apps screen, locate the 
Windows System section and click Control Panel.

• From other Windows operating systems, you could click Start > Settings > Control Panel.

4 In the Control Panel, click the link to uninstall programs. For example, if you are viewing the Control Panel by category, 
would click Uninstall a Program in the Programs area. If you were viewing by icon, you would click Programs and Features.

5 In the Uninstall or change a program area, click AutoReceive from the list of programs. 

6 Click Uninstall/Change.

Note: You must have administrator privileges on the computer from which you want to uninstall AutoReceive.

Note: If an earlier version of AutoReceive is installed to more than one user account on the same computer, only the 
first user who installed AutoReceive can uninstall from the Control Panel. If AutoReceive does not appear in the list of 
programs, it may have been uninstalled previously from another user account. In this case, do the following:
1 Access the user’s AutoReceive uninstall directory (for example, C:\Users\username\AppData\Local\

Program Files\AutoReceive\Uninstall_eMaxx_AutoReceive).
2 Double-click Uninstall eMaxx AutoReceive.exe.
3 Continue with step 7.
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7 In the User Account Control dialog box, click Continue to verify that you want to uninstall AutoReceive. 

8 In the Uninstall AutoReceive dialog box, click Uninstall to confirm that you want to uninstall AutoReceive. 

9 When the Uninstall Complete message appears, click OK to close the dialog box. 

10 Close the Control Panel.

11 Navigate to the directory where AutoReceive was installed and delete the AutoReceive folder.

• For 32-bit version of Windows: C:\Program Files\AutoReceive

• For 64-bit version of Windows: C:\Program Files(x86)\AutoReceive

Uninstall AutoReceive from Windows XP or Windows Server 2003

1 If AutoReceive is currently running, exit AutoReceive before you continue. 

To do so, right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2 If AutoReceive is running as a service, stop the service by doing the following:

a Click Start > Control Panel > Administrative Tools > Services (Windows XP) or Start > Control Panel > Administrative 
Tools > Component Services > Services (Windows Server 2003).

b Right-click AutoReceive.

c Click Stop.

3 Navigate back to the Windows Control Panel.

4 From the Control Panel, double-click Add or Remove Programs. 

5 In the Add or Remove Programs dialog box, click AutoReceive from the Currently installed programs list. 

6 Click Change/Remove.
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7 In the Uninstall AutoReceive dialog box, click Uninstall to confirm that you want to uninstall AutoReceive. 

8 When the Uninstall Complete message appears, click OK to close the dialog box. 

9 Close Add or Remove Programs.

10 Close the Control Panel.

11 Navigate to C:\Program Files\ and delete the AutoReceive folder.
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About Using AutoReceive 
Once configured, AutoReceive runs automatically while your computer is on, requiring no further interaction. If you need to 
add, modify, or remove a subscription, or change your connection settings, you can access the AutoReceive menu options 
by right-clicking the AutoReceive icon ( ). The AutoReceive icon appears in the notification area, at the far right of the 
Windows taskbar. 

While using AutoReceive, you may want to download results manually (that is, before the scheduled download of results), 
update subscriptions, change configuration settings, or perform troubleshooting or various other tasks. Below is a list of the 
AutoReceive tasks you might need to perform:

• Download results manually. Instead of waiting for the scheduled downloads of results, you can request immediate 
downloads, or you can request results that were downloaded previously. For instructions, see “Downloading Results 
Manually” on page 37.

• Manage subscriptions. Subscriptions need to be updated when new accounts are available, when you want to change 
the destination printer or folder for downloaded results, etc. For instructions on updating subscriptions as well as adding 
new ones or removing unnecessary ones, see “Managing Subscriptions” on page 39.

• Change notification settings. AutoReceive notifications appear in a small status window on your screen. You can change 
the default setting to display this window all the time, display it on top of other windows, turn it off, etc. For more 
information, see “Changing Notification Options” on page 45.

• Change connection settings. If your network connection changes (for example, from modem to LAN), or if login 
credentials change, see “Changing Connection Settings” on page 47.

• Start, stop, or restart AutoReceive. Occasionally, you may need to stop and restart AutoReceive. For instructions, see 
“Starting and Exiting AutoReceive” on page 50.

• Switch between Service mode and Classic mode. The most common way to run AutoReceive is in Service mode. 
However, you may need to switch to Classic mode in certain situations, such as using a Windows firewall or anti-virus 
application that impedes AutoReceive communications in Service mode. For instructions on switching between the two 
modes, see “Switching Between Service Mode and Classic Mode” on page 56.

• Troubleshoot. If you receive an error that AutoReceive cannot connect, you can respond to it by following the 
instructions in “Responding to AutoReceive Connection Failures” on page 58. Otherwise, if you are working with 
customer support, you may need to send status and error logs manually, view log files, or provide customer support with 
current configuration settings, as explained in these sections:

• “Sending Status and Error Logs Manually” on page 60.

• “Viewing the Print Log” on page 61.

• “Viewing the Status Log” on page 62.

• “Viewing the Configuration Settings” on page 64.

• Download product updates. AutoReceive updates are downloaded automatically, but you have the option to check for 
and install updates at any time. For instructions, see “Downloading Product Updates” on page 65.

Note: If AutoReceive is in Service mode (that is, running as a Windows service), the AutoReceive icon ( ) may not 
appear in the notification area. To access the AutoReceive user interface, see “Starting and Exiting AutoReceive” on 
page 50, which explains how to access the AutoReceive user interface when AutoReceive is running in Service mode as 
well as in Classic mode. For general information on Auto Receive running as a service, see “Running AutoReceive as a 
Windows Service” on page 4. 
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Downloading Results Manually 
Although AutoReceive is configured to receive results at the specific times or intervals you specify, you can request an 
immediate download or redownload of information. For instructions, see the following:

• “Downloading Current Results”, below.

• “Redownloading Results” on page 38.

• “Reprint Last Reports” on page 38.

Downloading Current Results 
Instead of waiting for the automatic or timed download of results, you can manually request an immediate download of 
results at any time. This may be useful when you are seeing a patient whose lab results are ready but not yet received. A 
manual download retrieves only completed results that have not yet printed or saved. This ensures that you do not receive 
duplicate results.

After a manual download, the next scheduled download excludes the results you already requested (this also applies for 
scheduled downloads). For example, if AutoReceive is configured to download results every two hours, but you request a 
manual download after one hour, the next download includes only those results received during the 60 minutes after the 
manual download.

Download Current Results 

Right-click the AutoReceive icon ( ) in the notification area, and then click Download Now.

The results, if available, are retrieved and saved or printed according to your subscription configuration.

Note: You cannot manually download results during the subscription configuration process. You must either complete the 
subscription configuration or cancel the configuration process prior to manually downloading results.
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Redownloading Results 
If you need to redownload results that have already been received, use the AutoReceive Redownload feature. With the 
AutoReceive Redownload feature, you can download results by date range as long as the results are not older than 90 days. 

Redownload Results 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Redownload Now.

2 In the From and To boxes, type a date range for the redownloaded documents using the format mm/dd/yyyy. 

3 Click Download.

Reprint Last Reports
AutoReceive allows the most recent set (batch) of downloaded PDF results to be reprinted. After a successful printable 
result download, the PDF results are stored in a temporary directory within the AutoReceive install directory to allow 
reprinting if requested. The Reprint Last Reports feature applies only to PDF results.

Reprint Last Reports

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Reprint Last Reports.

2 If reprinting is successful, a dialog appears informing you what was reprinted. 

If no results are available for reprinting, a dialog appears informing you that no reports are available for reprinting.

Note: If you are using the Enhanced file naming mode and need to redownload results, the redownloaded file names are 
generated using the current time. As a result, it is possible to have two identical files with different timestamps. You can 
determine which file to use by comparing the file names, and using the one with the latest timestamp. (For more 
information on the Enhanced naming mode, see “File Naming Mode” under “Step 2: Configure Subscription” on page 14.)

Note: You cannot download results that are more than 90 days old.
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Managing Subscriptions
Subscriptions are usually configured following installation and remain active until you remove or modify them. You can also 
add new subscriptions if new accounts become available.

Accessing Account and Subscription Summary Information 
You can access account and subscription summary information in two locations:

• Account Summary. The Account Summary dialog box provides a brief summary of all subscriptions that are configured 
for each account. In the Account Summary dialog box, you can determine which type of subscription is configured for the 
account, for example, HL7 or PDF, as well as the subscription name as specified during configuration. You cannot edit 
the subscriptions from the Account Summary.

• Subscription Summary. The Subscription Summary area provides a detailed view of the subscription parameters specified 
during configuration, including the associated accounts. You can edit the parameters by selecting the appropriate 
subscription and clicking Configure. See “Modifying a Subscription” on page 42 for more information.

Access the Account Summary 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Account Summary link. 

The Account Summary dialog box appears.

3 Review the accounts and subscriptions listed on the Account Summary dialog box.

Accounts are listed in alphabetical order, and the name of the subscription to which they are assigned is listed in the HL7 
and/or PDF column. Each account can be associated with only one HL7 subscription and one PDF subscription. 

4 When you are finished reviewing the summary, click Close.
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Access the Subscription Summary 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Choose from the following available subscriptions option button.

3 In the list of available subscriptions, click the desired subscription.

The parameters configured for the subscription appear in the Subscription Summary area.

4 To modify the configuration for the selected subscription, click Configure. Otherwise, when you are finished reviewing the 
summary, click Close.

For additional information on modifying subscriptions, see “Modifying a Subscription” on page 42.



Using AutoReceive 41

Adding a Subscription 
You can add a new subscription any time there is an available account that is not yet associated to a subscription type (HL7 
or PDF). Because HL7 and PDF subscriptions can each be associated with one or more accounts, you may need to configure 
only one HL7 subscription and one PDF subscription, so that all specified delivery options apply to each associated account. 
If necessary, you can configure multiple subscriptions, one HL7 and one PDF, for each account, specifying unique parameters 
such as print locations and result types.

Add a Subscription 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Create new subscription option button.

3 Click HL7 Test Results, Printable Test Results, or Clinical Document Upload. 

4 Click Continue.

For information on configuring the parameters for the selected subscription type, see one of the following:

• “Configuring HL7 Test Results” on page 17.

• “Configuring Printable Test Results” on page 22.

• “Configuring Clinical Document Upload” on page 28.

Note: If you select a subscription type (HL7 or PDF) that is already assigned to the available account(s), you are notified 
that it is unavailable for configuration.
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Modifying a Subscription
If you need to make changes to a subscription (for example, routing your results to a different printer), you can access the 
subscription’s existing configuration and make the necessary changes. You can also adjust the interval at which you receive 
results, or change account associations.

Modify a Subscription 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Choose from the following available subscriptions option button.

3 In the list of available subscriptions, click the subscription that you want to modify.

4 Click Configure.
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5 In the Subscription Configuration dialog box, make any necessary changes to the configuration, and then click Continue.

6 In the Associate Accounts dialog box, select or clear (as appropriate) the account(s) to which the modified subscription 
parameters should be applied. 
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7 Do one of the following:

• To return to the previous configuration dialog box to make changes prior to saving, click Back.

• To save your selections and return to the Manage Subscriptions dialog box, click Save.

If you are finished configuring subscriptions, click Close.

• To exit the subscription configuration without saving your changes and return to the Manage Subscriptions dialog box, 
click Cancel.

Removing a Subscription
If you are no longer receiving results from a service provider (Quest Diagnostics lab, or imaging center/hospital), you can 
remove the associated subscription from AutoReceive. Also, if there are any connectivity problems with a particular service 
provider, you can remove the subscription to avoid gathering error messages in the status log. When the problem is resolved, 
you can configure the subscription again. For information on the status log, see “Viewing the Status Log” on page 62.

Remove a Subscription 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Choose from the following available subscriptions option button. 

3 In the list of available subscriptions, click the subscription that you want to delete, and then click Delete.

4 When prompted, click Yes to confirm the deletion. 
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Changing Notification Options 
After AutoReceive is started, it remains running in the background until you log off or close the application. The AutoReceive 
icon ( ) in the notification area indicates that AutoReceive is running. When an AutoReceive communication session is in 
progress, that is, when results are being downloaded or when the application is being automatically updated, the 
AutoReceive icon ( ) changes to an AutoReceive communication icon ( ) until the session ends, at which time it reverts 
to the normal AutoReceive icon.

In addition to the AutoReceive communication icon ( ), you can monitor the status of communication sessions by 
choosing to display a small status window on your screen that provides information about the success or failure of 
communications activity such as connections, downloads, saves to disk, printing and system updates. 

The AutoReceive Status window consists of two lines, as follows: 

• The upper text line displays the state of AutoReceive, or what action is occurring. Idle indicates that AutoReceive is 
connected, but no data is being received at this time.

• The lower text line displays the time and completion status of the last communication session. If a communication 
session is unsuccessful, an alert message appears in this location. 

The service-related status messages that can appear include the following: 

You can drag the AutoReceive Status window from its default location above the notification area to any place on the screen. 
It remains in that position until you change it. 

You must have at least one subscription configured before you can set Notification Options. The option you set applies to all 
subscriptions; options for different subscription types cannot be separately configured.

For This Status This Status Window Appears

AutoReceive is loading

AutoReceive is in Service mode, and the service is connected

AutoReceive is in Service mode, and the service is stopped

AutoReceive is in Service mode, but the service is unavailable (this can be the 
result of various technical and security issues)
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Change Notification Options 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Notification Options.

2 Complete the Notification Options dialog box to determine when the status window appears and whether or not it appears 
on top of other windows. 

• Always. The status window appears after the startup process has completed, and remains visible until you exit 
AutoReceive.

• During AutoReceive activity. The status window appears when a communication session begins (for example, 
retrieval of HL7 or Printable results), and remains visible until two minutes after the session has completed. 

• During user-initiated activity. The status window appears only when you initiate a communication session (for 
example, Download Now, Redownload Now, Send Status/Errors, or Check for Update Now), and remains visible until two 
minutes after the session has completed.

• Never. The status window does not appear on your screen at any time.

• Always on Top. The status window stays on top of all other windows.

3 To save your selection, click Save.

Note: During AutoReceive activity is the default option. 

Notes:
• Regardless of which display option you select, you can close the AutoReceive Status window at any time by clicking 

Close in the upper-right corner of the screen.

• If you close the window manually, the window reappears at the start of the next communication session (unless you 
have chosen to never display it).
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Changing Connection Settings 
Connection settings include network configuration and login information. The network and login information configured 
during installation and setup remain active until you change them. To change the network settings or login information, see 
the following:

• “Changing Network Settings”, below.

• “Changing Login Information” on page 48. 

Changing Network Settings
The network settings determine how your computer connects to the Internet (via a dial-up modem or a LAN connection) 
and, if the connection uses a proxy server, the proxy server credentials (host name, port, user name, and password).

Typically these settings do not need to be updated unless your method for connecting to the Internet changes.

Change Network Settings 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Network Configuration.

2 In the Network Configuration dialog box, specify your connection type by selecting one of the following:

• Click the LAN option button if your computer accesses the Internet using a LAN.

Some LAN connections use a proxy server for HTTP and HTTPS connectivity. To determine if your LAN connection 
uses a proxy server, check your Internet browser’s settings by selecting Tools > Internet Options on the browser menu 
bar. Click the Connections tab. Click LAN Settings. If the Use a proxy server for your LAN check box is selected, your LAN 
connection uses a proxy server.

If your LAN connection uses a proxy server, select the Use proxy server check box, and complete the following:

a In the Proxy host box, type the name of the host for your proxy server.

b In the Port box, type the port number for your proxy server.

Note: If you receive an authentication error (your login information is not accepted), contact your system administrator 
to determine if changes have been made to your login credentials.
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If your proxy server requires you to log in, enter the corresponding username and password. This username and 
password combination is not your AutoReceive username and password.

a In the Username box, type the username for logging in to your proxy server.

b In the Password box, type the password for logging in to your proxy server.

• Click the Modem option button if your computer accesses the Internet using a modem. To automatically disconnect 
your modem after each transmission of results, select the Disconnect after finished download check box.

3 To save your changes, click OK.

Changing Login Information 
Ordinarily, only Quest Diagnostics personnel change the login information. If you need to change your login information, 
contact your system administrator to get the appropriate username and/or password before accessing the menu options to 
make changes. 

If you receive an authentication error (your login information is not accepted), contact your system administrator to 
determine if changes have been made to your login credentials. Your system administrator can provide you with valid login 
information and make sure your new information is successfully accepted.

Change Login Information 

1 Obtain the new login username and/or password from your system administrator.

2 Right-click the AutoReceive icon ( ) in the notification area, and then click Change Login Information.

3 Type the new account username and/or password, and then click OK. 

• If you entered a new username and password, a message box appears, indicating that the username has changed and 
that all existing subscriptions will be deleted. 

a Click OK to close the message box.

b Restart AutoReceive, and create one or more new subscriptions.

For information on starting AutoReceive, see “Starting and Exiting AutoReceive” on page 50.

For information on configuring subscriptions, see “Configuring HL7 Test Results” on page 17 and “Configuring 
Printable Test Results” on page 22.

Note: Changing login information affects subscriptions as follows:
• If you change only the password, your subscriptions are saved with the new password. 

• If you change both the username and password, the subscriptions for the previous username are deleted and you must 
reconfigure them.
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• If you entered only a new password, AutoReceive checks the connection with the new password. One of the following 
occurs:

• If the connection fails, a message box appears indicating that AutoReceive is unable to connect to the server. Click 
OK to close the message box. Enter the new password again and click OK. 

• If the connection is successful, no message appears. AutoReceive continues to run as usual. 
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Starting and Exiting AutoReceive 
AutoReceive can run in one of the two following modes:

• As a Windows service (referred to as Service mode)

• As a standard Windows application (referred to as Classic mode)

By default, AutoReceive is configured to run in Service mode. 

For instructions on starting and exiting AutoReceive in each mode, refer to the following sections:

• If AutoReceive is running in Service mode (that is, as a Windows service), see “Starting and Exiting AutoReceive (Service 
Mode)” below.

• If AutoReceive is running in Classic mode (that is, as a standard Windows application), see “Starting and Exiting 
AutoReceive (Classic Mode)” on page 53. 

Options for starting and restarting AutoReceive appear in the Windows Start menu. Exiting AutoReceive is accomplished via 
the AutoReceive menu.

Starting and Exiting AutoReceive (Service Mode) 
If AutoReceive is running in Service mode, there are two separate components of AutoReceive, each of which is started 
and/or exited independently: 

• Service. The first component, the AutoReceive service, starts automatically each time the computer is started and 
operates in the background. If the service should unexpectedly stop running for any reason, you are notified in the 
following ways:

• The following dialog box appears, informing you that the service has stopped: 

• The AutoReceive icon ( ) in the notification area appears with a red X ( ). 

If this occurs, the AutoReceive service can be restarted via the Restart Service option on the AutoReceive menu or via the 
Stop and Restart AutoReceive option on the Windows Start menu. 

• User Interface. The second component, the AutoReceive user interface, starts automatically each time the computer is 
started and you log in to Windows (as long as the AutoReceive option is in your Windows Startup folder). If the 
AutoReceive option is not in your Windows Startup folder (which is likely for Windows server operating systems), the 
AutoReceive user interface can be started via the Apps screen for Windows 8, Windows 8.1, or Windows Server 2012 R2, 
or via the Start menu for all other Windows operating systems.

Notes:
• For information on AutoReceive as a Windows service, see “Running AutoReceive as a Windows Service” on page 4.

• To determine whether or not AutoReceive is running in Service mode on your computer, view your current configuration 
settings as explained in “Viewing the Configuration Settings” on page 64.

• The AutoReceive service operates properly on Windows UAC operating systems only if you run it as an administrator. 
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The AutoReceive user interface continues to run until you exit it manually, or until you turn off your computer. Starting 
or exiting the AutoReceive user interface has no impact on the AutoReceive service, which continues to run regardless.

Because the service and user interface components operate independently, the following situations can occur:

• The AutoReceive service is running but the AutoReceive icon ( ) does not appear in the notification area. To access 
the AutoReceive user interface, see “Start the AutoReceive User Interface (Service Mode)”, below.

• The AutoReceive user interface may be running even if the service has been stopped. If you attempt to exit the 
AutoReceive user interface while the service is stopped, the following dialog box appears, informing you that you will not 
continue to receive subscription results until the service is restarted: 

To restart the AutoReceive service, see “Restart the AutoReceive Service (Service Mode)” on page 53.

Start the AutoReceive User Interface (Service Mode) 

Do one of the following:

• Start manually. To start AutoReceive manually, do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the AutoReceive tile and click 
Run as administrator.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click AutoReceive 
and select the options to run as an administrator.

One of the following occurs:

• If no instance of the AutoReceive user interface is currently running, the AutoReceive splash screen appears and the 
AutoReceive icon ( ) appears in the Windows notification area. 

Note: Only one instance of the AutoReceive user interface can be running at a time.
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• If an instance of the AutoReceive user interface is running, one of the following messages appears: 

• Start automatically. To start the AutoReceive user interface automatically by restarting Windows, do one of the 
following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Start screen, Apps screen, or desktop, press the 
Windows logo key + c. When the charms appear, click the settings charm ( ) and then click Power > Restart.

• From all other Windows operating systems, click Start > Shut Down, click Restart, and then click OK.

• Force a stop and restart. To force the AutoReceive user interface and service to stop and restart (even if they are running 
in another user’s session), do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the Stop and Restart 
AutoReceive tile and click Run as administrator. Respond to the User Account Control prompt to allow 
eMaxxAutoReceive.exe to make changes to the computer.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click Stop and 
Restart AutoReceive and select the options to run as an administrator.

The AutoReceive splash screen appears and the AutoReceive icon ( ) appears in the Windows notification area. (If the 
AutoReceive service cannot be restarted, AutoReceive reverts to Classic mode.) 

Message Description

Click Yes to restart AutoReceive. Any results 
that are in the process of being downloaded are 
downloaded when AutoReceive starts. 
Otherwise, click No to let the current instance of 
AutoReceive continue running.

Multiple users are set up on the AutoReceive 
computer, but only one AutoReceive session 
can be running at a time. Do one of the 
following:

• Click Yes to stop the AutoReceive session 
started by the specified user and start a new 
AutoReceive session under your user name. 
This has no effect on subscriptions; results 
continue to be downloaded as configured.

• Click No to let the AutoReceive session 
continue running, under the specified user.

It is not possible to restart AutoReceive via the 
Start menu. Your options are: 

• Stop the AutoReceive service via the 
Windows Control Panel.

• Stop the AutoReceive service by rebooting 
the computer.

Note: The steps above may vary slightly based on your Windows operating system.
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Restart the AutoReceive Service (Service Mode) 

If the AutoReceive user interface is currently running but the service isn’t, right-click the AutoReceive icon ( ) in the 
notification area, and click Restart Service. (If the AutoReceive user interface is not currently running, start it by following the 
instructions in “Start the AutoReceive User Interface (Service Mode)” on page 51.)

The AutoReceive service restarts and the icon appears without the red X ( ). If the AutoReceive service cannot be 
restarted, a message appears.

Exit the AutoReceive User Interface (Service Mode) 

1 Right-click the AutoReceive icon ( ) in the notification area, and click Exit.

2 When prompted, click Yes to confirm that you want to exit the user interface.

The AutoReceive user interface closes, but the AutoReceive service continues to run in the background. Results continue 
to be received and/or printed as normal.  

Starting and Exiting AutoReceive (Classic Mode) 
If AutoReceive is running in Classic mode (that is, as a standard Windows application) on your computer, the AutoReceive 
application opens each time the computer is restarted. AutoReceive continues to run until you either exit it manually, or until 
you turn off the computer. There is no service running in the background when AutoReceive is running in Classic mode.

If you need to manually exit AutoReceive due to printer, connectivity, or network issues, you must manually restart 
AutoReceive in order to resume receiving results. To discontinue receiving results without turning off your computer, you 
can exit AutoReceive manually.

Start AutoReceive (Classic Mode) 

Do one of the following: 

• Start manually. To start AutoReceive manually, do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the AutoReceive tile and click 
Run as administrator.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click AutoReceive 
and select the options to run as an administrator.

One of the following occurs:

• If no instance of the AutoReceive user interface is currently running, the splash screen appears and the AutoReceive 
icon ( ) appears in the Windows notification area. 

Note: If the AutoReceive icon in the notification area appears with a red X ( ) (indicating that the service has been 
stopped) when you exit the user interface, you will not continue to receive subscription results until the service is 
restarted. 
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• If an instance of the AutoReceive user interface is running, one of the following messages appears: 

• Start automatically. To start the AutoReceive user interface automatically by restarting Windows, do one of the 
following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Start screen, Apps screen, or desktop, press the 
Windows logo key + c. When the charms appear, click the settings charm ( ) and then click Power > Restart.

• From all other Windows operating systems, click Start > Shut Down, click Restart, and then click OK.

• Force a stop and restart. To force the AutoReceive user interface to stop and restart (even if it is running in another user’s 
session) do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the Stop and Restart 
AutoReceive tile and click Run as administrator. Respond to the User Account Control prompt to allow 
eMaxxAutoReceive.exe to make changes to the computer.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click Stop and 
Restart AutoReceive and select the options to run as an administrator.

The AutoReceive splash screen appears and the AutoReceive icon ( ) appears in the Windows notification area. 

Message Description

Click Yes to restart AutoReceive. Any results 
that are in the process of being downloaded are 
downloaded when AutoReceive starts. 
Otherwise, click No to let the current instance of 
AutoReceive continue running.

Multiple users are set up on the AutoReceive 
computer, but only one AutoReceive session 
can be running at a time. Do one of the 
following:

• Click Yes to stop the AutoReceive session 
started by the specified user and start a new 
AutoReceive session under your user name. 
This has no effect on subscriptions; results 
continue to be downloaded as configured.

• Click No to let the AutoReceive session 
continue running, under the specified user.

It is not possible to restart AutoReceive via the 
Start menu. Your options are: 

• Stop the AutoReceive service via the 
Windows Control Panel.

• Stop the AutoReceive service by rebooting 
the computer.

Note: These steps may vary slightly based on your Windows operating system.
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Exit AutoReceive (Classic Mode) 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2 When prompted, click Yes to confirm that you want to exit the application.  

AutoReceive closes, and the receipt of results is discontinued.

Automatic Restarts of AutoReceive 
AutoReceive can automatically recover from several error conditions, such as out-of-memory errors or failed downloads of 
results. The automatic recovery process includes restarting the AutoReceive service and user interface when AutoReceive 
is in Service mode. When AutoReceive is in Classic mode, however, the user interface cannot be started automatically, so 
you are notified with the following message when the user interface must be restarted:

After you click OK, be sure to start the AutoReceive user interface by clicking as explained in “Starting and Exiting 
AutoReceive” on page 50.

For more information on automatic recovery, see “Automatic Recovery” on page 67.

Note: To restart AutoReceive manually, see “Start AutoReceive (Classic Mode)” on page 53.
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Switching Between Service Mode and Classic Mode 
When AutoReceive is initially installed, it is configured to run either as a Windows service (Service mode) or as a standard 
Windows application (Classic mode), depending on whether it is a new install, or is obtaining settings from a previous install 
of AutoReceive (for more information, see “Running AutoReceive as a Windows Service” on page 4). Normally, once 
AutoReceive is successfully installed, it continues to run in its selected mode without interruption.

There are several environmental factors, however, that may impede AutoReceive’s ability to run successfully in Service 
mode; for example, if you have configured a subscription to save results to a network drive, or if you are using a Windows 
firewall or anti-virus application that impedes AutoReceive communications. In these situations, it is possible to change the 
AutoReceive operating mode from a Windows service to a standard Windows application to work around the issue. (It is 
also possible to change back to Service mode, as needed; for example, you might want to switch back to Service mode if the 
impeding issue is corrected.) 

Switch Between Service Mode and Classic Mode 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Advanced Settings.

2 In the Mode area, click either the Service or Classic option button to indicate the mode in which you want AutoReceive to 
operate.

3 When prompted, click Yes to confirm that you want to change the AutoReceive operating mode. 

The message that appears varies, depending on whether you are switching from Classic mode to Service mode, or vice 
versa, as follows.

• Switching from Classic mode to Service mode 

• Switching from Service mode to Classic mode 

Note: The currently configured operating mode is selected by default. To close the dialog box without making any 
changes, click Cancel.
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4 When prompted, click OK to exit AutoReceive. 

AutoReceive must be closed and restarted in order to run in the new mode.

5 To restart AutoReceive, click Start > All Programs > AutoReceive > Stop and Restart AutoReceive.

For more information about starting AutoReceive in either mode, see “Starting and Exiting AutoReceive” on page 50.
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Responding to AutoReceive Connection Failures 
AutoReceive opens and connects to the server each time you start your computer. If AutoReceive cannot connect to the 
server when it starts, either after a restart or when you initially turn on your computer, you are prompted to exit AutoReceive 
or let AutoReceive try to connect to the server. AutoReceive makes connection attempts every 10 minutes for a maximum 
of one hour, after which it tries to connect every 90 minutes for an indefinite period of time or until you close AutoReceive.

After 48 hours, if a connection has not been established, a dialog box appears from which you can either close AutoReceive 
or continue trying to connect at 90-minute intervals. If you choose to let AutoReceive continue trying to connect, the dialog 
box reappears after another 48-hour interval of unsuccessful connection. Once AutoReceive begins retrying connection at 
90-minute intervals, it continues to do so until connection is established—even if you have not responded to the dialog box 
prompts—or until you close it, which you can do at any time (see “Starting and Exiting AutoReceive” on page 50). 

Respond to AutoReceive Connection Failures 

1 In the Unable to Connect dialog box, do one of the following: 

• To close the program and discontinue connection attempts, click Terminate AutoReceive.

• To close the dialog box and allow AutoReceive to continue trying to connect with the server, click Continue Retry 
Attempts.

• To update the network configuration settings, click Network Configuration. (For more information, see “Changing 
Connection Settings” on page 47.)

• To reset your password to match a new password that has been established for you by Quest Diagnostics customer 
support, click Change Password. 

2 Do one of the following, based on the selection you made in the previous step:

• If you clicked Terminate AutoReceive, do one of the following to respond to the confirmation prompt: 

• To exit AutoReceive and terminate connection retry attempts, click Yes.

Notes:
• Exiting AutoReceive before a successful connection is made and restarting it later begins the cycle of retry attempts 

from the beginning; that is, every 10 minutes for one hour and every 90 minutes thereafter.

• If you experience lengthy periods of unsuccessful retry attempts, contact customer support.

Note: The Change Password button appears only if the connection failure is due to a change in your password (for 
example, customer support may need to reset your password to resolve a connection issue). When your password 
changes, you are prompted to enter the new password the first time you attempt to log in after the change has been 
made. 
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• To keep AutoReceive running, click No.

Connection attempts are made every 10 minutes for the first hour, and then every 90 minutes thereafter, until you 
exit AutoReceive.

• If you clicked Continue Retry Attempts, but reconnection has been unsuccessful for approximately 48 hours, do one of 
the following when the message prompt appears:

• To close AutoReceive, click Terminate AutoReceive.

• To allow AutoReceive to continue attempting to connect, click Continue Retry Attempts.

• If you clicked Change Password, do the following:

a In the AutoReceive Setup dialog box, type (and then re-type) the new password, and then click Change Password. 

b In the Change Password dialog box, click OK to acknowledge the change. 

c In the Unable to Connect dialog box, click Terminate AutoReceive, and then restart AutoReceive using the new 
password.
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Sending Status and Error Logs Manually 
AutoReceive improves the process of resolving system problems and diagnosing critical errors that may occur by 
automatically collecting information about your configuration and use of AutoReceive. The collected information is stored 
in log files that are saved on your computer, and the information is periodically forwarded (automatically) to Quest 
Diagnostics customer support. By default, AutoReceive sends status information every three days, and error information 
once a day, as needed. (If no errors occur on a particular day, then no error log is sent that day.)

Though AutoReceive is configured to send the status and error data automatically, you can also request that the status and 
error information be sent immediately. This is useful when you are working with customer support on a particular issue or 
error.

Send Status and Error Logs 

Right-click the AutoReceive icon ( ) in the notification area, and click Send Status/Errors.

The latest status and error log files that are stored on your computer are sent immediately to Quest Diagnostics customer 
support. (To verify that the status and/or error logs were sent successfully, you can view the status log. For details, see 
“Viewing the Status Log” on page 62.)

If an error occurs when attempting to send status and error logs, a message appears, indicating the error condition. 
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Viewing the Print Log 
Any print jobs that are sent to the configured printer while AutoReceive is running are saved to a print log. You can 
periodically check the print log to determine whether or not the print jobs have been completed properly. If needed, you can 
redownload files using the date and time values from the Status Log to retrieve files that did not print or save. See 
“Redownloading Results” on page 38 for more information on redownloading files.

View the Print Log 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click View Print Log.

2 Review the print messages. 

3 To refresh the print messages to ensure that you are viewing the latest information, click Refresh.

4 To clear all the messages, do the following:

a Click Clear. 

b When prompted, click Yes to confirm clearing the messages. 

5 When you are finished reviewing the print messages, click Close.

Note: For instructions on configuring the printer that is used for automatic printing (for a Printable results subscription), 
see “Configuring Printable Test Results” on page 22.

Note: You cannot clear print messages individually. If you click Clear, all messages are deleted from the Print Log.
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Viewing the Status Log 
Any errors that occur while AutoReceive is running are saved to a status log. You can periodically check the status log to 
determine if any results retrievals have failed. If needed, you can redownload files using the date and time values from the 
Status Log to retrieve files that did not print or save. For more information, see “Redownloading Results” on page 38.

Additionally, the status log tracks when automatic and manual product updates are installed to your computer. Check the 
status log to see the product version that was installed and if there were any errors while attempting to update AutoReceive.

Error Messages
The following table includes some common error messages and their meanings. 

Error Description

Error while executing:<subscription 
name><message>

Problem with the subscription, or service may be down.

A Remote error occurred while trying to 
contact the web service. Please try again 
later.

Service is down.

No Service Providers were found for this 
account.

Possible misconfiguration.

Authentication failure. Incorrect credentials (for example, username or password).

Cannot retrieve document types, 
authentication failure.

Incorrect credentials.

Error printing PDF file: <message> A corrupt PDF file or printer error. If corrupt file, contact your 
system administrator.

An error occurred while retrieving 
document types.

Service could be down.

An error occurred while trying to contact 
the web service.

Service could be down.

Execution Exception: a SOAP Fault occurred 
while trying to contact the web service. 
Please try again later.

AutoReceive is having trouble connecting to the server 
either during startup or while trying to receive results.

Error while executing: HL7 Test Results A 
SOAP Fault occurred while trying to 
contact the web service.

The retrieval of results for an HL7 subscription that is 
scheduled at a particular time fails because of the SOAP 
fault.

Error while executing: Printable Test 
Results A SOAP Fault occurred while trying 
to contact the web service.

The retrieval of the results for a PDF subscription that is 
scheduled at a particular time fails because of the SOAP 
fault.

Note: For assistance understanding or resolving error messages, see your system administrator.
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View the Status Log 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click View Status Log.

2 Review the error and/or system update messages. 

3 To refresh the status messages to ensure that you are viewing the latest information, click Refresh.

4 To clear all the messages in the status log, do the following:

a Click Clear. 

b When prompted, click Yes to confirm clearing the messages. 

5 When you are finished reviewing the status messages, click Close.

Note: You cannot clear error messages individually. If you click Clear, all messages are deleted from the AutoReceive 
Status Log window.
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Viewing the Configuration Settings 
The AutoReceive Configuration dialog box, accessed from the AutoReceive Status Log, allows you to view the current 
AutoReceive configuration settings. The configuration settings are read-only, and are to be used primarily when working 
with customer support for troubleshooting purposes.

View the Configuration Settings 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click View Status Log.

2 In the AutoReceive Status Log dialog box, click View Configuration. 

3 View the AutoReceive Configuration settings. 

4 To close the AutoReceive Configuration window, click OK.

5 To close the AutoReceive Status Log window, click Close.
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Downloading Product Updates 
AutoReceive updates are typically downloaded to your computer automatically as they become available. AutoReceive 
checks for these updates approximately every two days. Although you do not have to manually install the updates, you can 
check for product updates at any time and install them if they are available. Additionally, automatic updating may not be 
available for some installations. In these cases, you are notified that an update is available via a dialog box, as well as a 
flashing AutoReceive icon ( ) in the notification area. Manual updates are performed using the Check For Update Now 
menu option. 

The Status Log tracks all product updates that have been completed. You can check the Status Log to see when AutoReceive 
was updated and if the update was successful. See “Viewing the Status Log” on page 62 for more information on reading log 
file messages.

Download Product Updates 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Check For Update Now.

AutoReceive checks to see if an update is available.

2 If an update is available, you are prompted to install it. Click Yes to begin installation. 

3 When you are notified that the uninstall is complete, click OK.

The new version of AutoReceive is installed.

4 To confirm whether or not the update was successful, right-click the AutoReceive icon ( ) in the notification area, and 
then click Check For Update Now.

If the update was successful, the AutoReceive is up to date message appears.
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Automatic Recovery
AutoReceive attempts to automatically recover from the following situations:

• Failed subscription cycles. AutoReceive automatically restarts after two consecutive failed subscription cycles. The 
number of failed subscription cycles is not configurable. 

For failed result subscription cycles, AutoReceive also has built-in mechanisms for retrying at the point of failure and 
between the subscription cycles. For more information, see “Retry Attempts for Failed Downloads of Results” on 
page 68.

• Scheduler failures. The Scheduler is an internal AutoReceive process that tracks scheduling for result subscriptions and 
clinical document upload subscriptions. AutoReceive periodically monitors the Scheduler to ensure that it is running. If 
AutoReceive discovers that the Scheduler has been inactive for a specified number of minutes, AutoReceive restarts. The 
amount of time the Scheduler can be inactive before AutoReceive restarts can be configured via the heartbeatthreshold 
property, explained in “PSG Properties File” on page 70.

• Severe system-level error conditions. Severe system-level error conditions include problems such as out-of-memory 
errors. 

When any of these situations occurs, AutoReceive restarts in the configured mode (Service or Classic) and creates an entry 
in the error.xml file. In addition, AutoReceive also captures client attempts to restart. A large number of attempts by the 
client to restart AutoRecieve could indicate a problem that AutoReceive has not detected.

Restart attempts appear in the error.xml file in the Action tag, as in the following examples:

• Automatic restart:

<ErrorInfo>
<ErrorMessage>

<ErrorType>Uncaught Exception</ErrorType>
<DateTime>June 14, 2012 10:13:59 AM EDT</DateTime>
<ErrorTrace>computer_name - Java heap space</ErrorTrace>

</ErrorMessage>
</ErrorInfo>

• Client restart:

<ErrorInfo>
<ErrorMessage>

<ErrorType>Info</ErrorType>
<DateTime>July 12, 2012 9:08:42 AM EDT</DateTime>
<ErrorTrace>computer_name - AutoReceive was restarted by user</ErrorTrace>

</ErrorMessage>
</ErrorInfo>

The error.xml file is submitted to the hub on a regular schedule (approximately every three days) and when clients select 
Send Status/Errors from the AutoReceive menu.
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Retry Attempts for Failed Downloads of Results 
AutoReceive mechanisms for retrying after failed downloads of results fall into two categories:

• Retry attempts at scheduled subscription times. If results fail to download at a scheduled subscription time, 
AutoReceive retry attempts are governed by the following properties:

• retrycount. The number of times AutoReceive attempts to download results after a scheduled results download 
failure. 

• retrydelay. The seconds between AutoReceive attempts (as specified by retrycount) to download results.

The retry attempts at scheduled subscriptions times address situations of brief disruption, such as intermittent loss of 
Internet connectivity.

• Retry attempts between scheduled subscription times. If the results still fail to download after the retrycount and 
retrydelay cycle of attempts, AutoReceive retries to download results are governed by the following property:

• subscriptionretrydelay. The number of minutes after the maximum number of unsuccessful number of retries (as 
specified by retrycount) that AutoReceive attempts to retry downloading results. AutoReceive attempts to download 
results every n minutes (as specified by subscriptionretrydelay) until one of the following occurs:

• The result download is successful.

• The next scheduled result download fails.

If the next scheduled result download fails, AutoReceive attempts to download results per the retrycount and 
retrydelay cycle. If the next consecutive scheduled result download fails, AutoReceive restarts as per the 
autorecovery parameters.

The retry attempts between scheduled subscriptions times address situations of longer disruption, and they also address 
clients who have configured only a few download times.

Thus, if a scheduled result download fails, AutoReceive attempts to download results per the retrycount and retrydelay 
properties. If results still fail to download, AutoReceive attempts to download results per the subscriptionretrydelay 
property until successful or until the next scheduled results download. If the next scheduled results download fails and the 
subsequent retries fail, AutoReceive restarts as per the automatic recovery feature (explained in “Automatic Recovery” on 
page 67).

The retrycount, retrydelay, and subscriptionretrydelay properties can be configured in the psg.properties file as explained in 
“PSG Properties File” on page 70.

Retry Attempts Example
For this example, assume the default values for the following properties:

retrycount = 3 (times)

retrydelay = 30 (seconds)

subscriptionretrydelay = 10 (minutes)

Also assume that the client’s results subscription is configured to download results at the following times:

9:00 AM

5:00 PM
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If the first scheduled result download fails, AutoReceive attempts to retry the download as shown in the following table. This 
example shows all of the retry cycles and automatic recovery after two consecutive scheduled downloads of results fails. 

Time Event

9:00:00 AM Scheduled Subscription Time 1: Download of results fails.

Retry Cycle 1

9:00:30 AM Attempt 1: AutoReceive attempts to download again in 30 seconds as specified by retrydelay. Download 
of results fails.

9:01:00 AM Attempt 2: AutoReceive attempts to download again in 30 seconds as specified by retrydelay. Download 
of results fails.

9:01:30 AM Attempt 3: AutoReceive attempts to download again in 30 seconds as specified by retrydelay. Download 
of results fails. 

The retrycount is set to 3, so AutoReceive now waits for the time specified by subscriptionretrydelay.

Retry Cycle 2

9:11:30 AM After the ten minutes specified by subscriptionretrydelay, AutoReceive attempts to download again. 
Download of results fails.

Retry Cycle 3

9:12:00 AM to 
5:00:00 PM

The retry cycle continues every ten minutes as specified by subscriptionretrydelay until one of two events 
occurs:

• The result download is successful.

• Two consecutive scheduled result subscription downloads fail.

In this example, none of the result downloads is successful, and the next scheduled download is at 5:00 PM.

5:00:00 PM Scheduled Subscription Time 2: Download of results fails.

The subscriptionretrydelay cycle stops because this is the second scheduled result download failure. 
Because this is a new subscription time, however, the retrycount and retrydelay cycle begins.

Retry Cycle 4

5:00:30 PM Attempt 1: AutoReceive attempts to download again in 30 seconds as specified by retrydelay. Download 
of results fails.

5:01:00 PM Attempt 2: AutoReceive attempts to download again in 30 seconds as specified by retrydelay. Download 
of results fails.

5:01:30 PM Attempt 3: AutoReceive attempts to download again in 30 seconds as specified by retrydelay. Download 
of results fails. 

Automatic Recovery

5:02:00 PM Two consecutive scheduled subscription times have failed, so AutoReceive automatic recovery takes 
effect and AutoReceive restarts. 

AutoReceive attempts to download at the next scheduled subscription time. 
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PSG Properties File
The PSG properties file is an internal-only text file named psg.properties that is not installed with AutoReceive. Instead, it 
must be created and copied to the AutoReceive config folder manually when needed. It is intended to be used only by Quest 
Diagnostics personnel who are troubleshooting AutoReceive issues. 

Valid properties for the psg.properties file are listed in the table below. AutoReceive uses the default values until they are 
overridden by an entry in psg.properties. 

Format
From this PDF file, copy and paste the properties below into a text file, or type the properties using the following format. 
Enter only the properties you intend to use. AutoReceive uses the defaults for properties not in the psg.properties file.

retrycount = 3
retrydelay = 30
subscriptionretrydelay = 10
heartbeatthreshold = 30

Property Description Default Value

retrycount The number of times AutoReceive attempts to download results after a 
failure. The time between retries is determined by the value for 
retrydelay.

3 (times)

retrydelay The seconds between AutoReceive attempts to download results. 30 (seconds)

subscriptionretrydelay The number of minutes after an unsuccessful number of retries (as 
specified by retrycount) that AutoReceive attempts to retry downloading 
results until the result download is successful or until the next scheduled 
result download fails.

Note: The minimum value for subscriptionretrydelay is 10 minutes. The 
delay cannot be less than 10 minutes.

10 (minutes)

heartbeatthreshold The number of minutes the Scheduler can be inactive before 
AutoReceive restarts it. Scheduler restarts are written to the error.xml file 
located in C:\Program Files\AutoReceive\status. (The error.xml file is 
not created until an error condition exists.) 

Scheduler restart messages also appear in the status.log and debug.log 
files. For an example of scheduler monitoring in the debug.log file, see 
“Scheduler Monitoring” on page 71.

Note: This is an internal-only process that is invisible to clients. 

30 (minutes)
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Scheduler Monitoring 
The following is an excerpt from the debug.log file that shows AutoReceive monitoring of the Scheduler and the restarting 
of Scheduler (last line) due to missing heartbeats. 

2012-07-16 15:42:27,582   [SERVICE-2744] [pool-7-thread-1] DEBUG 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 103 - Running Scheduler 
monitoring
.
.
.
2012-07-16 16:01:56,562   [SERVICE-2744] [Thread-1] DEBUG com.medplus.util.socket.SocketServer 
147 - Listening for client connection on port 12400...

2012-07-16 16:04:55,461   [SERVICE-2744] [Timer-PoctUpload] DEBUG 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 76 - Heartbeat from Timer-
PoctUpload

2012-07-16 16:04:56,133   [SERVICE-2744] [Timer-DocUpload] DEBUG 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 76 - Heartbeat from Timer-
DocUpload

2012-07-16 16:11:56,727   [SERVICE-2744] [Thread-1] DEBUG com.medplus.util.socket.SocketServer 
147 - Listening for client connection on port 12400...

2012-07-16 16:12:25,463   [SERVICE-2744] [Timer-PoctUpload] DEBUG 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 76 - Heartbeat from Timer-
PoctUpload

2012-07-16 16:12:26,277   [SERVICE-2744] [Timer-DocUpload] DEBUG 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 76 - Heartbeat from Timer-
DocUpload

2012-07-16 16:12:28,858   [SERVICE-2744] [pool-7-thread-1] DEBUG 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 103 - Running Scheduler 
monitoring

2012-07-16 16:12:28,858   [SERVICE-2744] [pool-7-thread-1] ERROR 
com.medplus.autosend.client.scheduler.health.SchedulerHealthMonitor 119 - Restarting scheduler 
due to missing heartbeats!
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Common Problems and Solutions 
The following is a list of common AutoReceive issues.

• “AutoReceive Is Not Printing” on page 72.

• “AutoReceive Is Not Connecting to the Server” on page 75.

• “Account Number(s) Are Missing from Subscription” on page 75.

• “AutoReceive Won't Update” on page 75.

• “New Results Are in Care360 but AutoReceive Hasn't Printed Them” on page 75.

• “AutoReceive Did Not Print a Specific Result” on page 76.

• “AutoReceive Is Printing Results Later than the Client Expects” on page 76.

• “AutoReceive Is Printing Old Results” on page 76.

• “Result Is Printing at the Wrong Location or Isn't the Client’s” on page 76.

• “AutoReceive Is Printing Multiple Copies of the Same Results” on page 77.

AutoReceive Is Not Printing

Verify that the Computer Is On, the Client Is Logged in to Windows, and AutoReceive Is Running

❑ If the AutoReceive icon ( ) is not in the notification area of the system tray, restart AutoReceive:

❑ Classic mode, Windows 8: Apps screen > AutoReceive tile

❑ Classic mode, all other Windows operating systems: Start > All Programs > AutoReceive > AutoReceive

❑ Service mode, Windows 8: From the Apps screen, right-click the Stop and Restart AutoReceive tile and click Run as 
administrator.

❑ Service mode, all other Windows operating systems: Start > All Programs > AutoReceive, and then right-click Stop and 
Restart AutoReceive and select the options to run as an administrator.

❑ Right-click the AutoReceive icon ( ) and click Download Now. 

If AutoReceive starts with a connection error see “AutoReceive Is Not Connecting to the Server” on page 75. Otherwise, 
continue with the next section, “Do a Results Search in Hub Administration”.

Do a Results Search in Hub Administration 

❑ If there are no results to download, verify that the hub account is set up properly:

❑ For AutoReceive 4.6 and older: The hub account is configured for document queuing and/or HL7 queuing, and the 
hub account is associated with the correct provider account(s).

❑ For AutoReceive 5.0 and newer: The hub account is configured for observation queuing and/or HL7 queuing, and the 
hub account is associated with the correct provider account(s). 
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❑ Depending on the combination of enabled/disabled queuing options and provider accounts, check the following:

• Queuing enabled, provider account disabled. If document queuing, observation queuing, or HL7 queuing is 
enabled but the provider account associated with the client’s hub account is disabled, the results will not be listed 
Hub Administration. The results must be resent by Tier One through Lightning, not Quest Laboratory System 
(QLS).

• Document queuing disabled, provider account enabled. If document queuing is disabled (for AutoReceive 4.6 
and newer) and the provider account is enabled, the result is in the hub database but must be redownloaded after 
document queuing is enabled.

• Observation queuing disabled, provider account enabled. If Observation Queuing (for AutoReceive 5.0 and 
newer) is disabled and the provider account is enabled, the result is in the hub database but must be 
redownloaded after observation queuing is enabled.

• HL7 queuing disabled, provider account enabled. If HL7 queuing (HL7 files only) is disabled and the provider 
account is enabled, the result is in the hub database but must be redownloaded after HL7 queuing is enabled.

❑ Compare the Quest Diagnostics account number in Hub Administration against an HL7 message for leading zeros. 
For example, eGate (Interface Support Center (ISC)) trims leading zeros, but the hub must have the leading zero.

❑ Check to see when AutoReceive was enabled. It is possible the client hasn't had any new results since AutoReceive 
was activated.

❑ Verify that the AutoReceive account number is Lab Orders and Results Administration. 

❑ Check the set up in the laboratory information system (LIS).

❑ Verify that the client has results that should be available. It is possible that the client thinks results are available when 
they are actually not.

❑ If there is more than one provider account, check the following:

• Are they all activated? 

• Are they all associated to the hub account? 

• Are they all selected in the client’s AutoReceive configuration?

❑ Check the mode in which AutoReceive is running. If AutoReceive is running in Service mode and configured to write 
to a network folder or print to a network printer, verify the following:

• The AutoReceive service has been configured to write/print to the network. See “Configuring AutoReceive to 
Write to a Network Drive” in the AutoReceive Administrator Manual or AutoReceive User Manual.

• All users have access to any network folder or printer to which AutoReceive is configured to send results.

If AutoReceive is configured to write/print to the network and the results are still not available, it may be necessary 
to switch to Classic mode.

❑ If the transaction status shows as pending, do the following: 

❑ Right-click the AutoReceive icon ( ) and select Download Now. If results download successfully, the problem may 
have been one of the following:

• Results were not available earlier at the scheduled time.

• AutoReceive was not running earlier at the schedule time (for example, the computer was not on or the user was 
not logged in to Windows).

• The computer may have been in sleep mode and the Internet connection was lost.

• The printer may have been in sleep mode.

❑ Check the AutoReceive configuration to verify that all account numbers are associated to a subscription.
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❑ Determine whether or not the client is using a Quest Diagnostics lockdown computer. If not, verify that the user who 
is currently logged in to Windows has permissions to the AutoReceive folder (see “Verify That the Windows Users 
Have Write Access to the Hard Drive” on page 74 for specific instructions).

❑ Verify that the subscription is configured to print at the appropriate times and that the correct printer is selected.

❑ Verify that the AutoReceive username on the client’s computer is a hub account in Hub Administration and that it is 
configured correctly.

❑ Check the date and time on the client’s computer.

❑ If the transaction status shows ACKs, check the following:

❑ Is the printer selected in the subscription the same printer that the client is checking?

❑ Is the printer turned on and does it have paper?

❑ Is the printer online? Or is there an error code, or is it jammed?

❑ Is it possible that someone else picked up the results from the printer?

❑ Does the client have multiple locations? If so, is the other location possibly printing via AutoReceive, too?

❑ Are there additional account numbers that are not active or associated with subscriptions?

Verify That the Windows Users Have Write Access to the Hard Drive 

1 Navigate to one of the following folders:

• For 32-bit version of Windows: C:\Program Files\

• For 64-bit version of Windows: C:\Program Files(x86)\

2 Right-click the AutoReceive folder and click Properties > Security. 

3 In the Group or User Names list, click the user or user group who will use AutoReceive.

4 In the Permissions for... area, locate the Modify permission and select the corresponding Allow check box.

5 Click OK. 

Note: As of AutoReceive 8.0, the installation program automatically assigns access rights to all users, so this procedure 
should not be necessary for AutoReceive 8.0 unless the rights have been reverted.

Note: If the Security tab is not present, the user does not have Windows administrative privileges and must contact an 
administrator at the client site for access to the AutoReceive folder.
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AutoReceive Is Not Connecting to the Server 

❑ Verify that the client’s computer can connect to the Internet.

❑ If the client’s computer can successfully connect to the Internet, then use the AutoReceive installation on your computer 
to verify that you can connect to the hub. 

❑ If you can connect, confirm whether or not the client is using a firewall or proxy server.

❑ If the client has a firewall, ports 80 and 443 must be open for AutoReceive to connect. 

❑ If the client needs the IP address, ask them to use the server name instead: hubservices.medplus.com

❑ If the client has a proxy server, the proxy host and port and related username and password (if any) must be entered 
in the AutoReceive Network Configuration dialog box.

Account Number(s) Are Missing from Subscription 

❑ Verify that the account number(s) is set up and active in the hub.

❑ If the account number(s) was recently added in the hub, the client may need to restart AutoReceive. AutoReceive loads 
the available accounts numbers when starting.

❑ Obtain the AutoReceive username from the client computer and verify that the account number is associated with the 
correct hub account.

AutoReceive Won't Update 

❑ Confirm the current version of AutoReceive by right-clicking the AutoReceive icon ( ) and clicking About.

❑ Right-click the AutoReceive icon ( ), and click Check For Update Now. If the message AutoReceive is up to date appears 
but you have confirmed that AutoReceive is not running the most current version, verify that the client has write 
permission to the AutoReceive folder as explained in “Verify That the Windows Users Have Write Access to the Hard 
Drive” on page 74.

New Results Are in Care360 but AutoReceive Hasn't Printed Them 

❑ Confirm why the client expects more results to print.

❑ Is the client looking at the new results in Care360?

The Care360 new results list is not connected to AutoReceive. Thus, results that print via AutoReceive still show as 
new in the Care360 new results list.

❑ Does the client have a choice of groups to select when logging in?

AutoReceive may be configured to print for fewer account numbers than what is available to the client in Care360, 
even if the client has access to one or more care sites.

❑ Is the client viewing the count on the Lab Orders and Results main page?

These results aren't yet available to AutoReceive to download/print; unless there is a connection or configuration 
issue, they will be available within the hour.
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❑ Check to see if the result is a partial or final. If it is a partial, check the client's AutoReceive configuration to see if the 
subscription is set to print partials.

❑ Otherwise, see “AutoReceive Is Not Printing” on page 72.

AutoReceive Did Not Print a Specific Result 

❑ Verify that the client’s computer is on, that the client is logged in to Windows, and that AutoReceive is running.

❑ Use Hub Administration to do a results search to see if the result was available.

❑ If so, check to see if the result is a partial or final. If it is a partial, check the client's AutoReceive configuration to see 
if it is set to print partials.

❑ Otherwise, see “AutoReceive Is Not Printing” on page 72.

AutoReceive Is Printing Results Later than the Client Expects 

❑ Verify that the client’s computer is on, that AutoReceive is running, and that the client is logged in to Windows at the 
scheduled print times.

❑ Check the subscription configuration to ensure that the times or intervals selected are those the client wants.

❑ Verify the date/time on the client’s computer. 

AutoReceive Is Printing Old Results 

❑ Some clients may classify a result as “old” because they have already printed it manually via Care360.

❑ Have the client check the new results. Are the same results listed? If so, it is possible that results were re-queued, 
possibly due to a migration of historical data. If not, the results still could have been re-queued and already deleted. 

❑ Check the report view audit log in Lab Orders and Results to see if the result(s) has recently crossed to Care360.

❑ Otherwise, clear the queue.

Result Is Printing at the Wrong Location or Isn't the Client’s 

❑ Obtain an example of the result that does not belong to the client, and use the results search function in Hub 
Administration to investigate.

❑ Verify that the result was ordered under the same account number that the client expects it to be delivered to.

❑ Check the AutoReceive subscription configuration to confirm that that account number is associated with a subscription.

Note: AutoReceive may print later than the expected time due to the volume of requests being serviced by the hub. The 
hub can only handle a predetermined amount of requests at one time, so AutoReceive is designed to compensate for this 
volume by using retry logic. For information on the retry logic, see “Retry Attempts for Failed Downloads of Results” on 
page 68.
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AutoReceive Is Printing Multiple Copies of the Same Results 

❑ Make sure that the client has rebooted the computer since the multiple results started printing.

❑ Check the Result tab in Hub Administration to verify that the result did print multiple times.

❑ Check to see if the ACKS were part of a Download Now or a Redownload Now request from the AutoReceive menu.

❑ Check the times for the duplicate prints. If the times for each print are within several seconds of each other, the problem 
may be related to AutoReceive being installed on a server or installed on Windows XP Home Edition. 

❑ If multiple users are logged into Windows, AutoReceive starts when each user logs into Windows. If necessary, 
remove AutoReceive from the Startup folder (C:\Documents and Settings\All Users\Start Menu\Programs\
Startup) for all users except one. 

❑ Citrix® servers are not supported. Every time a user logs on to a Citrix server, AutoReceive is started again.

❑ Using either Interface Support Center (ISC) or Care360, verify that only one message was received for one of the results 
that the client reported printed multiple times.

❑ Verify that the client is running latest version of AutoReceive.

❑ If the problem is not resolved by any of the above, obtain the log files and the app.properties file and escalate. 

Note: As of AutoReceive 8.0, the installation program no longer adds AutoReceive to the Startup folder on 
Windows Server operating systems.
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Chapter 4: AutoReceive Configuration Tool
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• Installing the AutoReceive Configuration Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
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• AutoReceive Configuration Tool Properties File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84



AutoReceive Configuration Tool 79

About AutoReceive Configuration Tool
The AutoRecieve Configuration Tool is an application that provides a user interface for quickly switching between 
AutoReceive environments (Certification, Production, PSG Stage, Dev, and QA) for the hub results endpoint, FlexNet server, 
and product code. It is available from the Care360 Resource Center in two .zip files that support external and internal use 
as follows:

• CfgTool.zip. The CfgTool.zip file is for external use only. The CfgTool.zip file is typically provided by Client Interface 
Services (CIS) project managers to vendors who need to certify their EMR for receiving Quest Diagnostics lab results. 
As packaged, the AutoReceive Configuration Tool is ready for clients to use by limiting the environments to Certification 
and Production with hard-coded URLs. 

As distributed for external use, the AutoRecieve Configuration Tool runs in client mode. In client mode, the Environment 
list is populated with hard-coded external environments (Certification and Production), and all text boxes except for the 
AR Installed Dir text box are read-only.

Installation and operational instructions for client mode are in the AutoReceive Configuration Tool QuickStart 
(ar_config_tool.pdf), which is available from the Care360 Resource Center and can be distributed along with the 
CfgTool.zip file to clients.

• CfgTool_Internal.zip. The CfgTool_Internal.zip file is for internal use only by Quest Diagnostics personnel. The 
CfgTool_Internal.zip file contains the CfgTool.properties file, which allows the AutoReceive Configuration Tool to run in 
internal mode. In internal mode, the Environment list is populated with the external environments (Certification and 
Production) and any internal environments (PSG Stage, Dev, or QA) that are defined in the CfgTool.properties file. In 
addition, the values in all text boxes are editable.

For internal use of the AutoRecieve Configuration Tool, see the following:

• “Installing the AutoReceive Configuration Tool” on page 80.

• “Switching AutoReceive Environments” on page 81.

For a reference to the CfgTool.properties file, see “AutoReceive Configuration Tool Properties File” on page 84.
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Installing the AutoReceive Configuration Tool
The AutoReceive Configuration Tool must be installed to the same directory where AutoReceive is installed. 

Install the AutoReceive Configuration Tool

1 Navigate to the directory where AutoReceive is installed.

• 32-bit version of Windows:

C:\Program Files\AutoReceive

• 64-bit version of Windows:

C:\Program Files(x86)\AutoReceive

2 Extract the contents of the CfgTool_Internal.zip file as you usually do for other .zip files. For example, right-click 
CfgTool_Internal.zip and click WinZip > Extract to here.

The following files are extracted in the directory:

• CfgTool.exe. Starts the AutoReceive Configuration Tool.

• CfgTool.jar. Program use only.

• CfgTool.lax. Program use only.

• CfgTool.properties. Contains the internal URLs, endpoints, and product codes for the Certification, Production, PSG 
Stage, Dev, and QA environments.

After the AutoReceive Configuration Tool is installed, you can use it to quickly switch the environments AutoReceive 
connects to for downloading results and receiving updates. For instructions on using the AutoReceive Configuration Tool, 
see “Switching AutoReceive Environments” on page 81.

Note: The AutoReceive Configuration Tool cannot run if it is installed to a directory other than the AutoReceive installation 
directory, and no error message is displayed to indicate that.
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Switching AutoReceive Environments 
The AutoReceive Configuration Tool updates the environment URLs and product code in the AutoReceive app.properties file 
so that you can quickly switch environments while testing or troubleshooting AutoReceive without having to manually 
update the app.properties file. However, switching environments requires that you configure connection settings, add login 
credentials, activate AutoReceive, and create subscriptions for the new environment. 

Switch AutoReceive Environments

1 Make sure the CfgTools.properties file exists and that properties are specified. Typically the properties do not need to be 
changed, but if they do, see “AutoReceive Configuration Tool Properties File” on page 84 for more information.

2 If the AutoReceive user interface is currently running, exit it by right-clicking the AutoReceive icon ( ) and clicking Exit.

3 Navigate to the AutoReceive installation directory.

• 32-bit version of Windows:

C:\Program Files\AutoReceive

• 64-bit version of Windows:

C:\Program Files(x86)\AutoReceive

4 Double-click CfgTool.exe.

The Stop AutoReceive if Running dialog box appears: 

Caution! The AutoReceive Configuration Tool makes the following changes when updating to a new environment:
• The app.properties file is replaced.

• The credentials.properties file is deleted.

• Subscriptions are deleted (but not the folder itself).

• Log files are deleted (but not the folder itself).

• Status files are deleted (but not the folder itself).

Note: The AutoReceive Configuration Tool cannot run if it is installed to a directory other than the AutoReceive 
installation directory, and no error message is displayed to indicate that.
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5 Click OK.

The AR Config Tool dialog box appears: 

6 Update the AR Config Tool dialog box as follows: 

a If AutoReceive is installed to a directory other than the default, type the directory path in the AR Installed Dir text box, 
or click the button to the right of the text box to navigate to the directory.

b In the Environment list, select one of the following target environments:

• CERTIFICATION. Connects AutoReceive to the Certification environment for testing and certifying the ability of 
EMRs to receive lab results.

• PRODUCTION. Connects AutoReceive to the Production environment for receiving actual lab results 

• DEV. Connects AutoReceive to the Development environment.

• QA. Connects AutoReceive to the Quality Assurance environment

• PSG STAGE. Connects AutoReceive to the Product Support Stage environment, which allows for testing with 
Care360.

7 If necessary, update any of the following:

• Result Hub URL. The URL that connects to the Data Exchange hub so that results can be downloaded to AutoReceive.

• FlexNet URL. The URL that connects to the FlexNet server to ensure that AutoReceive can receive updates.

• Product Code. The product code specific to the environment to which AutoReceive is connecting.

Note: This screen capture of the AR Config Tool dialog box assumes that the CfgTools.properties file exists. If the 
CfgTools.properties file does not exist, or if it exists but does not contain properties for the PSG Stage, Dev, or QA 
environments, the AR Config Tool dialog box appears as it does in client mode. For information on using the AutoReceive 
Configuration Tool in client mode, see the AutoReceive Configuration Tool QuickStart. For information on the 
CfgTools.properties file, see “AutoReceive Configuration Tool Properties File” on page 84.

Note: The appearance of the Dev, QA, and PSG Stage environments in the Environment list is dependent on whether 
or not their properties are specified in the CfgTool.properties file. For example, if the CfgTool.properties file contains 
only the dev property for the Result Hub URL and the qa_fn property for the QA FlexNet URL, only the Dev and QA 
environments would appear in the Environment list. The PSG Stage environment would not appear because none of 
its properties were specified in the CfgTool.properties file.
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8 Click Update Configuration.

The following message appears, informing you that all AutoReceive configuration settings will be removed. These 
configuration settings include the AutoReceive user name and password, activation, and subscriptions.  

9 If you are sure existing configurations can be removed, click Yes. Otherwise, click No. 

The AutoReceive service is stopped (if it is running), the existing configuration and subscriptions are removed, the 
environment URLs and product code are updated, and the following message appears. 

10 (Optional) To view the cfgtool.log file, navigate to the AutoReceive directory, and open the file with Notepad or another 
text editor. The cfgtool.log file lists the status of each operation along with the changes that were made. 

11 Start AutoReceive by clicking Start > All Programs > AutoReceive > AutoReceive.

The Network Configuration dialog box appears.

12 Configure and activate AutoReceive as explained in “Log In to AutoReceive” on page 12. 

Caution! Make sure that the selected environment is correct and that you have the information necessary to create 
new configuration settings before continuing. The AutoReceive Configuration Tool makes the following changes when 
updating to a new environment:
• The app.properties file is replaced.

• The credentials.properties file is deleted.

• Subscriptions are deleted (but not the folder itself).

• Logs files are deleted (but not the folder itself).

• Status files are deleted (but not the folder itself).

Note: If the AutoReceive service cannot be stopped, an error message is displayed, and the AutoReceive Configuration 
Tool does not update the environment. Also, if any of the three values (Result Hub URL, FlexNet URL, and Product Code) 
are missing in the CfgTool.properties file for the specified environment, an error message is displayed.
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AutoReceive Configuration Tool Properties File
The Configuration Tool properties file is a text file named CfgTool.properties that is installed with the internal-only version of 
the AutoReceive Configuration Tool (CfgTool_Internal.zip). 

For an explanation of each property in the CfgTool.properties file, see “CfgTool.properties File Properties”, below. For a 
sample of the CfgTool.properties file, see “Sample CfgTool.properties File” on page 85.

CfgTool.properties File Properties
The properties in the CfgTool.properties file populate the main AutoReceive Configuration Tool dialog box as described in 
the following table.  

Note: Each environment (Certification and Production, PSG Stage, Dev, or QA) has three properties (Result Hub URL, 
FlexNet URL, and Product Code) that can be specified. In internal mode, all three of those properties must have a value or 
an error message appears when attempting to update an environment. 

Control Description Property

AR Installed Dir text box The directory where AutoReceive is installed.

By default, the AutoReceive Configuration Tool uses the directory 
that it is executed from. The value for the instdir property overrides 
that default.

instdir

Environment list The available environments. The Certification and Production 
environments are always listed. The PSG Stage, Dev, and QA 
environments are listed if any of their individual properties are 
specified.

N/A

Result Hub URL text box The endpoint for receiving results from the hub.

Note: The values for the prod and cert properties override the 
hard-coded defaults for the Production and Certification 
environments.

dev
qa
stage
prod
cert

FlexNet URL text box The URL for the FlexNet server that provides the AutoReceive 
updates.

Note: The values for the prod and cert properties override the 
hard-coded defaults for the Production and Certification 
environments.

dev_fn
qa_fn
stage_fn
prod_fn
cert_fn

Product Code text box The product code specific to the selected environment.

Note: The values for the prod and cert properties override the 
hard-coded defaults for the Production and Certification 
environments.

dev_pc
qa_pc
stage_pc
prod_pc
cert_pc
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Sample CfgTool.properties File
The following is an example of the CfgTool.properties file. This example includes the internal URLs, endpoints, and product 
codes for running AutoReceive with the Certification, Production, PSG Stage, Dev, and QA environments.

#
dev=http://flexnetserver.corp.medplus.com
qa=https://hubqa-AR02.qa.medplus.com
stage=https://shubservices.questemr.com
prod=https://hubservices.questemr.com
cert=https://cert.hub.care360.com

instdir=C:\\Program Files\\AutoReceive

dev_fn=https://flexnetserver.corp.medplus.com:9999/
qa_fn=http://172.18.58.191/
stage_fn=https://arupdate.care360.com/
prod_fn=https://arupdate.care360.com/
cert_fn=https://arupdate.care360.com/

dev_pc={ff617761-1ecb-11b2-92e4-8e85fc234514}
qa_pc={77096AE2-66AE-11DC-8314-0800200C9A66}
stage_pc={3006de56-6b6e-11dc-8314-0800200c9a66}
prod_pc={ff617761-1ecb-11b2-92e4-8e85fc234514}
cert_pc={3006de56-6b6e-11dc-8314-0800200c9a66} 
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Index

A
Abbreviations and acronyms x
Access

account summary 39
subscription options 39

Account summary, view 39
Activation 7, 13
Add

HL7 result subscription 17
printable (PDF) subscription 22
subscription 41

Advisory Message Report, example 25
Automatic recovery 55, 67
Automatic restart 55
AutoReceive communication icon 45
AutoReceive Configuration Tool

cfgtool.log file 83
CfgTool.properties file 84–85
client mode 79
external use 79
installation 80
internal mode 79
internal use 79
overview 79
properties file 84–85
switch environments 81–83

AutoReceive encountered a problem, message 52, 54
AutoReceive encountered an error and must be restarted, 

message 55
AutoReceive folder, set write access 74
AutoReceive icon 36
AutoReceive is already running, message 52, 54
AutoReceive service stopped icon 50

B
Book icon, help

closed xi
open xi

C
Care360 Resource Center 79
Care360, new results list 75
cfgtool.log file 83
CfgTool.properties file 84–85
CfgTool.zip file, availability 79
Change

connection settings 47
login credentials 48
notification options 45

Classic mode
start and exit AutoReceive 53
switch to 56

Client mode 79
Clinical document upload

configure subscription 28–29
Document Upload directory 29

Closed help book icon xi
Configuration Tool (see AutoReceive Configuration Tool)

Configure
clinical document upload subscription 28
HL7 result subscription 17
LAN connection 12
modem connection 12
order in which results are sorted or printed 22
printable (PDF) result subscription 22
write to network drive 30

Connection failure, respond to 58
Connection settings, modify 47

D
Delete subscription 44
Disable days of the week 15
Document Upload folder 29
Documentation, related xiii
Download

current results 37
product updates 65
redownload by date range 38
reprint most recent batch of PDF results 38

E
Edit subscription 42
Enhanced file naming 14, 18, 22
Error information, send manually 60
error.xml 67
Exit AutoReceive

Classic mode 53
Service mode 50

F
Failed subscription cycles 67
Failure, connection 58
Features, new in this release vii
File naming mode 14, 18, 22

H
heartbeatthreshold property 70
HL7 test result

configure subscription 17–21
file name extension 17, 20
sort results 17, 18

Hub Administration
ACK’d result transaction 74
Pending result transaction 73
provider account 72
queuing 72

I
Icon

AutoReceive 11, 36
AutoReceive communication 45
AutoReceive service stopped 50
closed help book xi
help page xi
open help book xi
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Install
AutoReceive 7–10
AutoReceive Configuration Tool 80

Internal mode, AutoReceive Configuration Tool 79

L
Log file

send status and error 60
view print 61
view status 62

Log in
change login information 48
change settings 47
failed attempts 11
initial 11

M
Maintenance tasks 36
Manual download

current results 37
redownload results by date range 38
reprint most recent batch of PDF results 38

Menu, AutoReceive 11, 36
Mode, file naming 14, 18, 22
Modem

configuration 12
speed 5

Modify
connection settings 47
login information 48
subscription 42

N
Naming, file 14, 18, 22
Network drive

configure for AutoReceive 30–31
test 20

New features vii
Notification area, AutoReceive icon viii, 11, 36, 50
Notification options 45

O
Open help book icon xi
Options, change notification 45
Overview

AutoReceive 2
AutoReceive Configuration Tool 79
Classic mode 53
installation 7
manage subscription 39
Service mode 4, 50
subscription 14–16
tasks 36

P
Page icon, help xi
Password

change 58
enter during installation 12

Port 443 75
Port 80 75
Print log, view 61
Print order

file date 22
file name 22

Printable (PDF) result
problem saving to network drive 26
test PDF file 26

Printable (PDF) test result
Advisory Message Report 25
configure subscription 22–27
report order 25
Result Summary Report 24

Problems and solutions (see Troubleshooting)
Product updates, check status 62
PSG properties file 70
psg.properties file 70

R
Redownload results 38
Related documentation xiii
Remove subscription 44
Reports, reprint last 38
Requirements

operating system 5
printer 6

Restart
automatic 55
service 53

Result summary report, example 24
Results

manual download 37
redownload 38
reprint most recent batch of PDF results 38

Retry attempts, failed connection 58
Retry attempts, failed download of results

example 68–69
overview 68

retrycount property 68, 70
retrydelay property 68, 70

S
Scheduler monitoring

debug.log file example 71
minutes of inactivity 70

Scheduler, definition 67
Send status and error information 60
Service mode

overview 4
restart options 50
Run as Administrator option required 4, 11
start and exit AutoReceive 50
stopped icon 50
switch to 56

Set connection settings 47
Settings

change connection 47
change login 47
change notification 45

Standard file naming 14, 18, 22
Start AutoReceive

Classic mode 53
Run as Administrator option 11
Service mode 50

Status information, send manually 60
Status log

error messages 62
product update status 62
view 62

Status window 45
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Subscription
account summary 39
add 41
configuration options 14
definition 2
failed cycles 67
modify 42
overview 14–16
remove 44
summary 39

Subscription summary, view 39
subscriptionretrydelay property 68, 70
Summary

account 39
subscription 39

Switch AutoReceive environments 81–83
Switch between Service mode and Classic mode 56
System requirements

overview 5
printer 6

System-level error conditions 67

T
Test in Question (TIQ) result 25
Test Not Performed (TNP) result 25
Troubleshooting 72–77

account numbers are missing from subscription 75
AutoReceive did not print a specific result 76
AutoReceive hasn’t printed Care360 new results 75
AutoReceive is not connecting to the server 75
AutoReceive is not printing 72–74
AutoReceive is printing multiple copies of the same 

results 77
AutoReceive is printing old results 76
AutoReceive is printing results later than clients expect 76
AutoReceive won’t update 75
result is not the client’s 76
result is printing at wrong location 76

U
Unable to connect, message 58
Uninstall AutoReceive

from User Account Control (UAC) operating systems 32
from Windows XP or Windows Server 2003 33
overview 32

Universal naming convention (UNC), network drive 
configuration 31

User Account Control (UAC) operating systems viii
Username, enter during installation 12

V
View

account summary 39
print log 61
status log 62
subscription summary 39

W
Windows 7

convention in this manual viii
notification area viii

Windows 8
convention in this manual viii
notification area viii

Windows administrator
required for installation 7
required for running service 4, 11
required for uninstallation 32

Windows Server 2003, uninstall AutoReceive 33
Windows service, running AutoReceive as 4
Windows User Account Control (UAC) operating systems

documentation conventions viii
uninstall AutoReceive 32

Windows XP, uninstall AutoReceive 33
Write access for AutoReceive folder 74



 89

We’d Like to Hear From You 

After you have used the documentation and/or help for this product, please take a moment to give us your feedback. To do 
so, click the following link to open a PDF form and respond to the questions: 

Click here to open the Feedback Form

After you have completed the form, do one of the following (from within the form) to submit your feedback:

• Email your responses. To send your responses to us electronically, click Submit by Email. 

Your default email application is used to email the form content to us.

• Print the form. To print the completed form and then mail or fax it to us, click Print Form. 

Our address and fax number appear at the bottom of the form.

Thank you!
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We’d Like to Hear From You 


After you have used the Care360 AutoReceive documentation, please take a moment to give us your comments.  
Respond to the questions below, and then click Submit by Email at the end of this form (or print and then fax or mail your 
comments to us at your convenience).  Thank you! 
 


ü What sections/topics do you refer to most often?


ü When do you refer to the documentation?  Check all that apply.


ü How is the level of detail in the documentation?


ü Does the documentation adequately explain how to get started using the product?


ü If not, what information is missing?


ü How do you primarily search for information in the documentation?


ü Was there a topic or index entry you looked for, but couldn’t find?


 Getting started  Learning about new features  Performing a specific task  Troubleshooting


Too little Just right Too much


Yes No


Full text search Table of contents Index Scan


Yes No


ü If so, what was it?


ü Did you find any errors in the documentation?
Yes No


ü If so, please list the section/topic, and describe the error:


ü Any other comments about the documentation?







Please tell us about yourself (optional)


May we contact you for additional feedback?


Send your comments to us


Email Address:


Phone:


Address:


Company:


Title/Position:


Name:


Yes No


To email them, click the Submit by Email button and follow the prompts.  To fax or mail them, click the Print Form button, 
then fax or mail them to us. 


By Mail:
Quest Diagnostics
Attn: Technical Communications Manager 
4690 Parkway Drive
Mason, OH 45040 USA


By Fax:


(800) 381-4048





